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PREFACE  
The fourth edition of the California Energy Commission Style Manual supersedes the 2015 
version. It is intended to assist California Energy Commission (CEC) staff and others who 
prepare CEC reports. 

“Reports” for this style manual include staff papers, staff reports, Lead Commissioner reports, 
Commission reports, consultant reports, guidelines, manuals, and project reports for the 
Energy Research and Development Division and the Clean Transportation Program of the Fuels 
and Transportation Division. 

This manual is on the CEC website at http://www.energy.ca.gov. The manual and report 
templates for use with Microsoft Word® are on the CEC’s EnergyNet Intranet website at 
http://energynet/Exec/doc_production/index.html.  

If you have any questions about the information provided in this manual, please contact the 
Media and Public Communications Office (MPCO) at (916) 654-4989. 

  

https://ww2.energy.ca.gov/2015publications/CEC-180-2015-002/CEC-180-2015-002.pdf
https://ww2.energy.ca.gov/2015publications/CEC-180-2015-002/CEC-180-2015-002.pdf
http://energynet/Exec/doc_production/index.html
http://energynet/Exec/doc_production/index.html
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ABSTRACT  
The fourth edition of the Commission Style Manual helps staff members, contractors, and 
project researchers write clear and concise reports and papers for the California Energy 
Commission (CEC). This manual helps ensure that those reports and papers incorporate CEC-
approved style. 

This edition includes a new chapter on making documents accessible to readers with 
disabilities. As of July 1, 2019, each director or secretary of a state agency must post on the 
agency website a signed California Department of Technology Website Accessibility 
Certification form or the agency’s own form confirming that the website complies with state 
law and the Web Content Accessibility Guidelines 2.0. 

The word usage chapter in the 2015 editing has been eliminated. Staff members may consult 
the EnergyNet intranet “Document Production and Notices” pages for word usage, as well as 
Section 11 of The Gregg Reference Manual: Tribute (Eleventh) Edition by William A. Sabin. 

This document, based upon The Gregg Reference Manual and the EIA Writing Style Guide, 
April 2015, is available online with links from the CEC “EnergyNet” intranet website and at the 
California Energy Commission main website, www.energy.ca.gov. Microsoft Word® files for 
the document templates, covers, and credits pages can be downloaded from those pages as 
well.  

The Media and Public Communications Office may revise this document as necessary. Please 
check for the latest version at http://energynet/Exec/doc_production/index.html. 

Keywords: Plain language, acronyms, formatting, usage, accessibility 

Please use the following citation for this report: 

Garfield-Jones, Susanne, Lana McAllister, and Carol E. Robinson. 2020. Style Manual: Fourth 
Edition. California Energy Commission. Publication Number: CEC-180-2020-XXX. 

 

 
  

https://www.eia.gov/about/eiawritingstyleguide.pdf
https://www.eia.gov/about/eiawritingstyleguide.pdf
https://www.eia.gov/about/eiawritingstyleguide.pdf
https://www.eia.gov/about/eiawritingstyleguide.pdf
https://www.energy.ca.gov/
https://www.energy.ca.gov/
http://energynet/Exec/doc_production/index.html
http://energynet/Exec/doc_production/index.html


iv 
 

  



v 
 

TABLE OF CONTENTS  
 
ACKNOWLEDGEMENTS ......................................................................................................... i 
PREFACE ............................................................................................................................ ii 
ABSTRACT ......................................................................................................................... iii 
TABLE OF CONTENTS ......................................................................................................... v 
LIST OF FIGURES ............................................................................................................. vii 
LIST OF TABLES .............................................................................................................. viii 
EXECUTIVE SUMMARY ........................................................................................................ 1 

Plain Language .............................................................................................................. 2 
Preparing Energy Commission Reports ............................................................................ 2 

CHAPTER 1: What This Manual Is About ............................................................................... 3 
Introduction ................................................................................................. 3 
Why Should You Use This Style Manual? ........................................................ 3 
Updates to the Style Manual ......................................................................... 4 
Major Updates Since Last Edition................................................................... 4 

CHAPTER 2: Report Contents, Formatting, and Styles ........................................................... 5 
Report Templates ......................................................................................... 5 
Blank Pages ................................................................................................. 6 
Figures, Graphs, and Tables .......................................................................... 6 
Report Contents ........................................................................................... 7 

Use of Colors in Graphs and Figures, Size of Fonts, and Other Graphic Elements ............... 8 
Footnotes .................................................................................................... 8 
Page Breaks ................................................................................................. 8 
Pagination ................................................................................................... 9 
Table of Contents, Lists of Figures and Tables ............................................... 9 
Report Formatting Styles .............................................................................. 9 

CHAPTER 3: Publication Steps for  Papers, Reports, and Presentations ................................. 20 
Reports and Papers .................................................................................... 20 

Change in Publication Review ....................................................................................... 20 
Report Sequencing ..................................................................................... 22 
Errata and Additional Revisions to Reports ................................................... 23 
Reproduction ............................................................................................. 24 

CHAPTER 4: Parts, Contents, and General Formatting of Reports ......................................... 25 
Report Sections .......................................................................................... 25 
Cover and Credits Pages for Energy Commission Reports .............................. 26 

Covers ........................................................................................................................ 26 



vi 
 

Report Credits Page ..................................................................................................... 26 
Other Types of Commission Reports ............................................................ 28 
Publication Numbers ................................................................................... 29 

Suffixes at End of Publication Numbers ......................................................................... 29 
Other Report Sections ................................................................................ 29 

Acknowledgements Page (Optional) .............................................................................. 29 
Preface Page (Optional) ............................................................................................... 30 
Abstract, Keywords, and Citation Page (Mandatory) ....................................................... 30 
Table of Contents ........................................................................................................ 32 
Executive Summary ..................................................................................................... 33 
Chapters and Section Headings .................................................................................... 34 
References .................................................................................................................. 35 
Glossary ...................................................................................................................... 35 
Bibliography ................................................................................................................ 35 

CHAPTER 5: Appendices and Attachments .......................................................................... 36 
Important Note About Copyrights and Permissions ....................................... 36 
Appendices ................................................................................................ 36 

Formatting and Editing of Appendices ........................................................................... 37 
Appendices Publication Numbers .................................................................................. 37 
Page Numbering of Appendices .................................................................................... 37 
Appendices as Part of the Main Report .......................................................................... 38 
Appendices as Documents Separate From the Main Report ............................................ 39 
Appearance in Table of Contents .................................................................................. 40 

Attachments .............................................................................................. 40 
CHAPTER 6: Document Accessibility for Energy Commission Reports .................................... 42 

What Is Document Accessibility? ................................................................. 42 
Seven Principles to Creating an Accessible Word Document .......................... 42 

Step One: Font Style and Size ...................................................................................... 43 
Step Two: Appropriate Use of Color .............................................................................. 43 
Step Three: Add Alternative Texts and Captions ............................................................ 47 
Step Four: Construct Simple Tables .............................................................................. 49 
Step Five: Use Meaningful Hyperlink Text ..................................................................... 51 
Step Six: Use Built-In Formatting Styles ........................................................................ 52 
Step Seven: Check Accessibility .................................................................................... 52 
Roles and Responsibilities ............................................................................................ 53 
Document Accessibility Resources ................................................................................ 53 

CHAPTER 7:  Preparing Accurate, Consistent Reports and Report Content Styles .................. 54 
Writing Style .............................................................................................. 55 
Acronyms and Abbreviations ....................................................................... 56 
Bulleted Lists ............................................................................................. 59 

Rules for Bullets .......................................................................................................... 59 
Format for Bulleted Lists .............................................................................................. 60 



vii 
 

Capitalization ............................................................................................. 60 
Adjective Phrases and Adverbs .................................................................... 61 
Compound Adjectives ................................................................................. 61 
Internet and Email Addresses ..................................................................... 62 
Italics ........................................................................................................ 62 
Language of Report .................................................................................... 62 
Legislation (Referencing Legislation in Energy Commission Documents) ........ 62 
Numbers .................................................................................................... 63 
Page Breaks ............................................................................................... 64 
Percentages ............................................................................................... 64 
Punctuation ............................................................................................... 64 

Brackets ..................................................................................................................... 64 
Colon and Semicolon ................................................................................................... 65 
Commas ..................................................................................................................... 65 
Commas in Dates ........................................................................................................ 65 
Hyphen (-), En Dash (–), Em Dash (—) ......................................................................... 65 
Period Spacing ............................................................................................................ 66 
Quotation Marks (“”).................................................................................................... 66 

Special Characters and Symbols .................................................................. 66 
Underlining ................................................................................................ 66 

CHAPTER 8: Footnotes and References in the Text ............................................................. 67 
References Within the Report Body ............................................................. 67 
Footnote Citations ...................................................................................... 67 

CHAPTER 9:  Submitting Files to the  Media and Public Communications Office ..................... 68 
Word and PDF Files .................................................................................... 68 

Document Properties ................................................................................................... 68 
Graphics and Figures .................................................................................. 69 

COMMON EDITOR/PROOFREADING MARKS ........................................................................ 70 
 

 
LIST OF FIGURES 

Figure 1: Low-Resolution Graphic Downloaded From Internet ................................................ 6 
Figure 2: Example of a Graphic Properly Used in a Report ..................................................... 7 
Figure 3: Example of Abstract/Keyword/Citation Page ......................................................... 30 
Figure 4: Example of Table of Contents .............................................................................. 33 
Figure 5: Example of Appendix as Part of Main Report ........................................................ 38 
Figure 6: Example of a "Slip Sheet" for Appendices ............................................................. 40 
Figure 7: Colour Contrast Analyzer ..................................................................................... 44 
Figure 8: Incorrect Contrast Pie Chart Example ................................................................... 46 
Figure 9: Final Pie Chart .................................................................................................... 47 



viii 
 

Figure 10: Format Picture .................................................................................................. 48 
Figure 11: Describing Graphic Using Alt Text ...................................................................... 49 
Figure 12: Table Properties ................................................................................................ 50 
 

LIST OF TABLES 
Table 1: Summary of Formatting Styles for Energy Commission Reports............................... 10 
Table 2: Formatting Style Matrix for Energy Commission Reports ......................................... 11 
Table 3: Author and Project Manager Review Steps ............................................................ 20 
Table 4: Commissionwide Review Process Steps ................................................................. 21 
Table 5: CEC Publishing Steps ........................................................................................... 22 
Table 6: Example of Use of Color and Nonredundant Symbols ............................................. 46 
Table 7: Common and Acceptable Acronyms and Abbreviations ........................................... 57 
 



1 
 

 

EXECUTIVE SUMMARY 
The fourth edition of the California Energy Commission’s (CEC) Style Manual assists staff 
writers in producing consistent-looking documents in plain language. 

For this edition, the style manual addresses document compliance with Web Content 
Accessibility Guidelines 2.0. These guidelines help make Web content, including reports using 
Microsoft Word® and Adobe Acrobat®, accessible to a wider range of people with disabilities, 
including those with blindness and low vision. As of July 1, 2019, all report templates comply 
with these guidelines, and the CEC mandates that report writers use these templates.  

Other changes include the following: 

• The new cover has the CEC logo on the top-left corner and the Natural Resources 
Agency logo in the top-right corner. 

• The margins on each side and on the bottom of each report template page have been 
reduced to allow more text on the page, thus reducing the amount of paper used. 

• The authors expanded the “Citation Information” subsection to include information on 
citing articles, reports, journals, books, and Web pages. 

• The list of acronyms in the chapter “Preparing Consistent, Accurate Reports and Report 
Content Styles” has expanded. These acronyms can be used on subsequent references 
in the abstract and executive summary of a CEC report 

• In the “Glossary” subsection, the manual writers request that not only an acronym be 
spelled out, but defined. 

• The chapters “Energy Commission Presentations”; “Required Elements for Fact Sheets, 
Brochures, Posters, and Other Types of Printed Materials”; “Submitting Files to the 
Media and Public Communications Office”; and “Use of the California Energy 
Commission Seal” have been deleted. Information from these chapters is available on 
EnergyNet, the Commission’s intranet site available only to Commission staff. The 
information can be found by clicking the icon “Document Production and Notices.” 

• The chapter on “Word Use and Misuse” from the previous edition of the style manual 
has been eliminated for this version. CEC staff may find these entries under the 
“Document Production and Notices” icon on EnergyNet. For more information on 
usage, check The Gregg Reference Manual, Tribute (Eleventh) Edition by William A. 
Sabin and To the Point: A Dictionary of Concise Writing by Robert Hartwell Fiske. 

• The California Energy Commission encourages the acronym “CEC” in its documents. 
 

The bases for this style manual are The Gregg Reference Manual and the EIA Writing Style 
Guide. Any issues not covered in this style manual may be found in these references. Other 
resources used for this style manual edition include the Merriam-Webster Dictionary; The 
Chicago Manual of Style, 16th Edition; To the Point; and The Elements of Style by William 
Strunk Jr. and E. B. White. 

http://www.w3.org/TR/WCAG20/
http://www.w3.org/TR/WCAG20/
https://www.eia.gov/about/eiawritingstyleguide.pdf
https://www.eia.gov/about/eiawritingstyleguide.pdf
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Plain Language 
The CEC strongly endorses the use of plain language in its documents. Plain language is 
mandated by the California and U.S. governments. According to the U.S. government at 
PlainLanguage.gov, plain language can be understood the first time it is read or heard. Plain 
language uses short sentences, the active voice, everyday words, and logical organization. It 
helps readers find what is needed quickly. Hence, the government’s business is readily 
accessible to the public. 

Preparing Energy Commission Reports 
Staff members preparing a report for the CEC should consult this style manual. The 
“Document Production and Notices” link on the CEC’s EnergyNet intranet page has resources 
including report templates that can help writers prepare documents. Staff members who have 
additional questions may contact CEC Chief Editor Carol Robinson of the Media and Public 
Communications Office at (916) 654-4989. 

 

https://www.plainlanguage.gov/
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CHAPTER 1: 
What This Manual Is About 

Hard writing makes easy reading. 
— Wallace Stegner 

Introduction 
The CEC produces hundreds of presentations, reports, brochures, and other printed items 
each year. These publications1 are used to convey information, printed and sent to libraries, 
and placed on the CEC website (http://www.energy.ca.gov). 

CEC management believes that all documents need to have a consistent design; be 
grammatically consistent, clear, and concise; and have an instant identity with other materials 
the CEC has prepared. 

As an author, you can demonstrate skill, creativity, and pride in your work as well as an 
obligation to meet the expectations of your audience and the CEC. Readers should be able to 
rely on consistent, professional quality—regardless of subject matter. 

CEC Media and Public Communications Office staff understands that you need to know what is 
expected to produce a quality publication. This style manual clarifies publication style 
conventions, including the approval process and formatting of publications. One chapter is 
devoted to writing, including strategies for organizing a document.  

The CEC does not intend to create a grammar text. Rather, staff wants to address the items 
that seem most vexing. For a complete and comprehensive source, the CEC recommends 
using The Gregg Reference Manual. 

Why Should You Use This Style Manual? 
By using this style manual, you will ensure that CEC documents look consistent and 
communicate well. 

There are legal grounds for “good writing.” California Government Code Section 6219 states: 

6219. (a) Each department, commission, office, or other administrative agency of state 
government shall write each document that it produces in plain, straightforward language, 
avoiding technical terms as much as possible, and using a coherent and easily readable style. 
(b) As used in this section, a “state agency document” means any contract, form, license, 

                                        

 
1  The terms ”publications” and “documents” are used interchangeably throughout this manual to refer to CEC 
reports, papers, brochures, flyers, handouts, presentations, and all other types of printed and delivered materials. 

https://www.energy.ca.gov/
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announcement, regulation, manual, memorandum, or any other written communication that is 
necessary to carry out the agency responsibilities under the law. 

Updates to the Style Manual  
The style manual is a working document. Media and Public Communications Office (MPCO) 
staff will regularly review this manual and incorporate any necessary changes into future 
editions.  

Major Updates Since Last Edition 
There have been changes throughout the style manual correcting errors and mistakes. The 
following are the main updates since the previous edition. 

• The new cover has the CEC logo on the top-left corner and the Natural Resources 
Agency logo in the top-right corner. The MPCO Editing Unit prepared this style manual 
using one of several report templates that ensure the content is accessible to readers 
with disabilities. 

• The margins on the sides and the bottom of each report template page have been 
reduced to allow more text on the page, thus reducing the amount of paper used. 

• The list of acronyms in the chapter “Preparing Consistent, Accurate Reports and Report 
Content Styles” has expanded. These acronyms can be used on subsequent references 
in the abstract and executive summary of a CEC report 

• In the “Glossary” subsection, MPCO requests that an acronym be not only spelled out, 
but defined. 

• The chapters “Word Use and Misuse”; “Energy Commission Presentations”; “Required 
Elements for Fact Sheets, Brochures, Posters, and Other Types of Printed Materials”; 
“Submitting Files to the Media and Public Communications Office”; and “Use of the 
California Energy Commission Seal” have been deleted. Information from these 
chapters is available on EnergyNet, the CEC’s intranet site available only to CEC staff. 
The information can be found by clicking the icon “Document Production and Notices.” 

• This style manual includes a chapter on document accessibility for impaired readers. 
The chapter outlines instructions on checking a report for accessibility compliance with 
the Americans with Disabilities Act. 

• The abstract should be on an odd-numbered, right-hand-facing page. 
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CHAPTER 2: 
Report Contents, Formatting, and Styles 

All California Energy Commission (CEC) reports contain the following sections, in the following 
order: 

• Cover page (required) 
• Credits page on the reverse side of cover (required) with legal disclaimer (mandatory 

on committee, staff, consultant, and research and development and Clean 
Transportation Program project reports)  

• Acknowledgements page (optional) 
• Preface (optional) 
• Abstract, keywords, and citation page (required) 
• Table of Contents (required, followed by List of Figures and List of Tables, if needed) 
• Executive Summary (optional but required on policy and project documents) 
• Body of the report 
• References (if applicable) 
• Glossary/Acronyms (If more than 10 acronyms or abbreviations are used, it is 

required. Definitions are also required.) 
• Bibliography (if applicable) 
• Appendices (if applicable) (Create a separate volume if very large.) 
• Attachments (if applicable)  

Later chapters discuss report contents and parts. 

Report Templates 
Prepare the report using one of the CEC-approved templates. The templates are Americans 
with Disabilities Act (ADA) accessible. Use the report typographic styles described in this 
manual. They are summarized in Table 1: Formatting Style Matrix for Reports. The style 
template—and boilerplate cover and credits page templates—are on the CEC EnergyNet 
intranet website under the icon “Document Production and Notices.” Do not deviate from 
the report template. 

All CEC computers should be set up to have the Commission style formats as the default in 
Microsoft Word. All other styles can be stripped from Word formatting palette. If a report has 
been written elsewhere, it may need to be reformatted using the CEC style.  

For formatting help, please see the step-by-step instructions on EnergyNet at 

http://energynet/Exec/doc_production/formatting/index.html. 

http://energynet/Exec/doc_production/index.html
http://energynet/Exec/doc_production/formatting/index.html
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Blank Pages 
Insert blank pages after the following pages so that the next section begins on the right-hand 
side. 

• Following single-page acknowledgement page if there is no preface 
• Following table of contents, list of figures, and list of tables 
• Following executive summary (if used) 

Place the disclaimer page for a staff paper behind the cover. The credits page for other reports 
is on the backside of the cover. Please make sure the abstract is on an odd-numbered, right-
hand-facing page. Do not put blank pages at the end of chapters so that next chapter begins 
on the right side. Only Chapter 1 needs to be on an odd-numbered, right-hand-facing page.  

Figures, Graphs, and Tables 
Figures, graphs, and tables (graphics) should be clear and readable. Source lines are 
required on all figures and graphs. 

The graphic should be introduced in the paragraph before and explained fully. The explanation 
of the graphic may be used as alternative (alt) text for document accessibility. Do not 
download and use low-resolution graphics from the Internet, such as in Figure 1. While these 
may appear fine on your computer monitor, when printed, the picture may look blurry. 

Figure 1: Low-Resolution Graphic Downloaded From Internet 

 

Example of logo downloaded from the CEC website and enlarged for effect. 
Graphics or photos used on the internet are typically done as 72 or 96 dots per inch 
(dpi) graphics files. Most reports are printed at 300 dpi. Therefore, the graphic will 

appear very blurry when printed. 

Source: California Energy Commission, Media and Public Communications Office 

 

Writers should provide alternative text for the graphic. In the document, go to the “File” tab. 
Under “Info,” select “Check for Issues,” then select “Check Accessibility.”  

The title or label of graphic should be typed in as part of the report and not part of the 
graphic. The reason is that the graphic may have to be resized to fit the page. If the label is 
part of the graphic, the size of the label will change depending on the resizing of the graphic. 

The figure title should use the “Figure Titles” style in Tahoma, 12 pt., bold, centered similar to 
the example in Figure 1. The figure title should be in title case, be centered, and have no 
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more than two lines. Fonts used within figures, graphs, and tables should be sans serif, which 
work best as screens with low resolution make serif fonts like Lucida Bright more difficult to 
perceive.  

Captions or sources listed below a graphic should use the style specified in the formatting 
matrix (Tahoma bold 10 pt. for captions below the graphic, Tahoma normal 10 pt. for source 
lines). Captions and sources should also be separate from the figure or table and not 
embedded in the graphic file because of accessibility issues. 

If used, the list of figures and list of tables should be generated automatically in a manner 
similar to the table of contents. If a figure or table title is particularly long, manually edit it in 
the list of figures/list of tables as you see fit. 

Original graphics files must be submitted with your report. If a chart or graph was created in 
Excel, then that Excel file should also be submitted with the report. 

Report Contents 
CEC staff and contractors must use the report typographic styles described in this manual. 
They are summarized later in Table 1: Formatting Style Matrix for Reports. The style 
template—and boilerplate cover and credits page templates—are on the “EnergyNet” intranet 
website at http://energynet/Exec/doc_production/index.html and on the Energy Commission 
website at http://www.energy.ca.gov. (Commission contract managers may send the report 
template to the contractors.) 

Figure 2: Example of a Graphic Properly Used in a Report 

 
SOLARA is the first apartment community in California to be fully powered by the 
sun and the first project delivered under the California Energy Commission New 

Solar Homes Partnership Program. 
Photo Credit: Community HousingWorks, developer/owner of SOLARA. 

https://caenergy-my.sharepoint.com/personal/carol_robinson_energy_ca_gov/Documents/Archive/leftovers/
https://caenergy-my.sharepoint.com/personal/carol_robinson_energy_ca_gov/Documents/Archive/leftovers/
https://www.energy.ca.gov/
https://www.energy.ca.gov/
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Use of Colors in Graphs and Figures, Size of Fonts, and Other Graphic 
Elements 
Often the CEC’s reports are photocopied in black and white. Therefore, it is important to use 
colors in charts, graphs, and figures that will reproduce well on a photocopy machine. Think 
and plan for future readers because a chart may be photocopied from a photocopy. 
Information must be clear and easy to understand; numbers should be large and clear enough 
to be read easily. 

Moreover, graphics may need to be reduced to fit on a page within the text. Make sure the 
font size in the graphic is large enough to be read if the graphic is shrunk. Graphics or figures 
should be created at a minimum of 300 dpi. 

Footnotes 
Use footnotes (not endnotes) in CEC reports.2 Use them sparingly to briefly clarify terms or 
concepts that the average reader may not understand. Place footnotes at the bottom of the 
page on which they appear. Do not place footnotes at the end of a section.  

Because Tahoma 10 pt. in superscript is too small to read in the text, use 12 pt. in superscript. 
The footnote number is part of the Quick Style Gallery in Microsoft Word®, and the CEC style 
is reflected in the report templates. Occasionally, the writer will have to increase the footnote 
number font size in the text manually to 12 pt. 

Insert footnotes using Word footnote feature: Insert > Reference > Footnote. Footnote 
numbering should automatically readjust as footnotes are added or deleted.3 Enter footnote 
numbers after periods or commas. 

Do not use footnotes in report or chapter titles, and do not footnote headings, subheadings, or 
graphics titles. Moreover, please do not use footnotes in the preface, abstract, or executive 
summary. 

Footnote numbers are superscript in the text but not in the footnote itself. 

Page Breaks 
If a subheading appears at the bottom of the page, but the text jumps to the next page, put a 
page break before the subheading. Font metrics may be slightly different depending on the 
computer operating system. Including a page break will ensure that headings are not left 

                                        

 
2 The footnote number appears in the text as a superscript; the footnote is at the bottom of the page.  

3 Microsoft Word will automatically superscript the footnote number at the bottom of the page. The Footnote 
Reference should be in Tahoma 12 pt., as shown in these examples. Use Footnote Text style for the footnote 
itself. Do not add an extra space between footnotes; the spacing is built into the style. 
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alone at the bottom of a page with no content. Furthermore, insert a page break to ensure the 
content of a graphic is on one page. 

Pagination 
Use Tahoma 12 pt. for page numbers, centered at the bottom of each page. 

Pagination begins on the acknowledgements or preface page (as a Roman numeral – i, ii, iii 
...) and continues in lowercase Roman numerals through the abstract, table of contents, and 
lists of figures and tables (if used). The cover and credits pages are not numbered. Number 
the blank pages but do not put "This Page Intentionally Left Blank" on blank pages. 

On the first page of the executive summary (or Chapter 1 if there is no executive summary), 
begin numbering in Arabic numerals (1, 2, 3…) and continue sequential numbering throughout 
the document. See Chapter 5 for numbering appendices pages. 

Table of Contents, Lists of Figures and Tables 
The table of contents should be generated automatically using Microsoft Word pull-down 
menu: Insert > Reference > Index and Tables feature. (Appendices or attachments must be 
added manually.) The table of contents is based on the style headings assigned to each 
section. Check the table of contents to make sure it has been updated correctly after each 
series of edits. Checking that chapters and headings agree with the page numbering should be 
the last task before creating the Adobe Acrobat PDF or printing the final master copy for 
reproduction.  

Report Formatting Styles 
The following is a summation of the styles used in all CEC reports. Exceptions to this summary 
include the final Integrated Energy Policy Report and other specialized reports. Those 
exceptions must be cleared through the director of communications and external 
affairs in advance of the design and layout. 

The CEC uses Tahoma, a highly readable sans serif that meets the needs of the new report 
format, advances document accessibility, and works with any version of Microsoft Word® on 
PCs and Apple Macintosh® computers. 
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Table 1: Summary of Formatting Styles for Energy Commission Reports 
Style Type Definition 

Body (Normal) Text Tahoma 12 pt., leading over 15 pt. 
leading, with 7 pt. spacing at the end 
of the paragraph, align left. 

Bullets (regular and numbered) Tahoma 10 pt., 0.2-in. hanging indent 

Acknowledgments, Preface, Abstract, 
Table of Contents, List of Tables of 
Figure Heading (Section Title) 

Tahoma 17 pt., leading over 15 pt., 
BOLD, CENTERED, ALL CAPS 

Heading 1 (Document Title) Tahoma 29 pt., Bold, Aligned Left  

Heading 2 (Chapter Title) Tahoma 20 pt., Bold, Aligned Left 

Heading 3 (Subheading) Tahoma 15 pt., Bold Over 15 Pt. 
Leading, Aligned Left 

Heading 4 (Sub-subheading. Please use 
as sub-subheading for executive 
summary.) 

Tahoma 13 pt., Bold Over 15 Pt. 
Leading, Aligned Left 

Heading 5 (Sub-sub-subheading.) Tahoma 12 pt., Bold Over 15 Pt. 
Leading, Aligned Left 

Heading 6 (Sub-sub-sub-subheading. 
Use sparingly.) 

Tahoma 12 pt., Italics, leading over 15 
pt. aligned left 

Figure and Table Titles Tahoma 12 pt., Bold, Centered 

Caption Text Tahoma, 10 pt., bold, align margins 
with figure margins. 

Credits for Photos and Source 
Information 

Tahoma, 10 pt., normal 

Credit: Text Goes Here.  

Source: California Energy Commission, Media and Public Communications Office 

 

The following formatting style matrix provides a more comprehensive description of the 
approved style formats. 
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Table 2: Formatting Style Matrix for Energy Commission Reports 
Style Type Definition Example 

Normal 

 

Use for all “regular” 
text that is not 
assigned a special 
style (for example, 
heading, bullet, 
caption, and so 
forth) 

Tahoma 

12 pt. 
Line spacing 15 
pt. 

Align left 
Space 0 pt. 
before paragraph 
Space 7 pt. after 
paragraph 

 

Tahoma (12 pt.) 
The quick, fast fox jumped over the 
lazy, brown dog. 

  

Appendix Text Same as Normal The quick, fast fox jumped over the 
lazy, brown dog. 

Attachments The CEC does not 
require that its 
style format be 
used in 
documents that 
are attachments. 

 
Not applicable 

Body Text See “Normal” 
above 

 

Bullets Tahoma 12 pt. 
Space 0 pt. 
before bullet 
Space 0 pt. after 
bullet 

Text Indent 0.2" 
Additional level 
bullets are each 
indented another 
0.2"  

 

• Bullet item number 1 
• Bullet item number 2 

o Item number 2a 
o Item number 2b 
 Subbullet to 2b 

Follow last bullet with two hard 
returns to separate from next 
paragraph. 
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Captions Tahoma bold, 10 
pt. 

Align left; indent 
to align with 
image 

Space 6 pt. 
before paragraph; 
space 7 pt. after 
paragraph.  

Caption should be 
the width of the 
graphic. Brief 
captions are 
preferred; 
however, some 
graphics may 
require a 
lengthier caption. 
Typically, captions 
should not 
introduce new 
information. 
Please use only 
high-resolution 
photographs of 
150 to 300 dpi. 
Do not use 72 dpi 
photos or 
graphics 
“borrowed” from 
websites. A 
source line is 
required on all 
graphics, 
including graphs, 
photos, and 
tables. 

Figure 3: BiPV on Carport 

 

Building-integrated solar photovoltaic 
roofing materials used in a carport by 
Solar Utility of Culver City, California. 
Photo Credit: United Solar Systems 
Corporation 

Credits for Photos 
and Source 
Information 

Tahoma normal 
10 pt., align 
margins with 
table margins 
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Equations Use special 
characters if 
necessary. 
 
Center on a new 
line. 

Every equation 
presented must 
be referred to and 
explained in the 
text. 

You can use 
Equation Editor in 
Microsoft Word to 
create the 
equation. 

If special 
characters are 
used to create the 
equation, make 
sure typefaces 
are supported and 
available across 
various computer 
operating systems 
or platforms. 
Occasionally, 
special characters 
may not be 
available in a 
standard 
typeface. 

E=mc2 

CO2 
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Figure and Table 
Titles 

Arial bold, 12 pt. 

Align center. 

Space 12 pt. 
before paragraph; 
space 0 pt. after 
paragraph. 

Text in Figure 
Title case. 

Colon after the 
figure/table 
number and 
before title. 

Figures and tables 
can be numbered 
in a chapter 
number format 
(Figure 2-1, Table 
2-3, and so forth) 
or numbered 
sequentially 
throughout the 
entire report. Be 
consistent 
through the entire 
document. Do not 
mix formats. 

Figure XX: This Is an Example 

Note: Title is in title case with no 
period at the end of the title unless 
it is a complete sentence. 

Figures, Graphs, 
Charts, Drawings, 
Photographs 

Figures should be 
centered. Align 
captions with left 
edge of figure. 

Avoid the use of 
Word text boxes 
wherever possible 
and insert the 
figures directly 
into the 
document. 

Every figure 
presented must 

For an example, see Figure 1 on 
page 12. 
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be referred to in 
the text. 

If the figure is a 
graphic, picture or 
photograph, it 
should be at least 
300 dpi. Do not 
use low-
resolution 
Internet 
pictures (72 to 
96 dpi). 

Use colors in 
graphics that 
provide enough 
contrast. (See 
chapter on 
“Document 
Accessibility.”) 

Footnotes Tahoma normal 
10 pt.  

Align left. 

Space 0 pt. 
before paragraph, 
space 5 pt. after 
paragraph. 

Footnote numbers 
in the text are 
Tahoma normal 
12 pt. in 
superscript. 

Footnote numbers 
are superscript in 
the text but not in 
the footnote 
itself. 

For an example of a footnote, see 
page 7. 

Graphs Do not title a 
graph while it is 
being created in 
separate 
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software, such as 
Microsoft Excel. 
The figure title 
should label the 
graphic. The 
author, however, 
should strive for 
clarity. 
• Please label all 

axes. 
• Use sentence 

case. 
• Include units. 
Make sure point 
size is at least 14 
pt. on all labels. 

Glossary Use a table with 
the word and 
acronym or 
abbreviation in 
the left column, 
and the definition 
in the right 
column.  

Do not show the 
gridlines of the 
table. Do not use 
multiple tabs to 
“create” a table 
but use the Word 
table function. 

Greenhouse gas (GHG)—Any gas 
that absorbs infrared radiation in 
the atmosphere. 

Heading 1 Tahoma, bold, 29 
pt. 

Align left 

Space 54 pt. 
before paragraph, 
space 7 pt. after 
paragraph. 

 

Style 
Manual: 
Fourth 
Edition 
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This Is 
Heading 1 

Heading 2 Tahoma, bold, 20 
pt., title case 

Align left 

Space 0 pt. 
before paragraph, 
space 24 pt. after 
paragraph. 

Page break before 
paragraph. 

½ pt. border 
below text, not 
underlined. 
Lucida Bright, 
bold, 14 pt. 

Line spacing 15 
pt. 

Align left. 

Space 12 pt. 
before paragraph, 
space 2 pt. after 
paragraph 

CHAPTER 1: 

This Is Heading 2 

Heading 3 Lucida Bright bold 
15 pt. 

Line spacing 15 
pt. 

Align left. 

Space 12 pt. 
before paragraph, 
space 2 pt. after 
paragraph 

This Is Heading 3 
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Heading 4 Lucida Bright bold 
13 pt. 

Line spacing 15 
pt. 

Align left 

Space 10 pt. 
before paragraph, 
space 2 pt. after 
paragraph 

This Is Heading 4  

Heading 5 Tahoma bold, 12 
pt. 

Line spacing 15 
pt. 

Space 10 pt. 
before paragraph, 
space 2 pt. after 
paragraph 

This Is Heading 5 

Heading 6 Tahoma italic, 12 
pt. 

Line spacing 15 
pt. 

Align left. 

Space 0 pt. 
before paragraph, 
space 2 pt. after 
paragraph 

This Is Heading 6, to be used 
sparingly! 

Page Numbers Tahoma  
12 pt. 
Centered 
Bottom of page 

See bottom of this page for an 
example. 

References – 
Bibliography 

Normal style 
0.25" Hanging 
Indent 

This is an example of a reference 
that goes into a second line. The 
hanging indent approximates the 
end of the first last name. 
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Table Column 
Headings and Table 
Data Cells 

Arial or Tahoma 
Columns Heads – 
Bold 
Data cells – No 
Bold  

Size depends on 
amount of data in 
cell. Do not crowd 
cells. 

 

Title for following 
sections: 
Acknowledgements, 
Preface, Table of 
Contents, Abstract, 
and Executive 
Summary 

Tahoma  
Bold 
17 pt. 
All uppercase 
Centered 

Space 0 pt. 
before 
Space 12 pt. after 

Note: Use a soft 
return to break 
the title into neat 
and easier-to-
understand 
segments.  

This Is the Title Style  
For the Sections  
Mentioned on the Left 

 

PREFACE 

Source: California Energy Commission, Media and Public Communications Office 
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CHAPTER 3:  
Publication Steps for  
Papers, Reports, and Presentations 

Reports and Papers 
Before beginning, you should understand how the CEC publication process works. Publishing a 
report or paper with the CEC should not be all consuming. It essentially breaks down into 
three areas (See Table 3 below.): 

1) Steps 1 through 7 are generally prereview. 
2) Steps 8 through 20 reflect the general steps for document review.  
3) Steps 21 through 26 involve publishing a report and distributing final master copies. 

Review this style manual at the beginning of the writing process and follow the format and 
styles in your CEC reports. 

CEC staff should use the latest version of the Publication Approval Form (CEC 5 Form) 
available on the Commission “EnergyNet” intranet at 
http://energynet/Exec/doc_production/templates/. 

Change in Publication Review 
To streamline publication review, the Editing Unit in the Media and Public Communications 
Office edits the report once instead of twice, as it had previously. After the Editing Unit review, 
the document goes to the director of the division that composed the report. The revised CEC 5 
Form reflects the change. The following tables outline the CEC’s report review and publication 
steps. 

Table 3: Author and Project Manager Review Steps 

Step 
Number 

Review Step 

1 Author plans and conceptualizes the report and determines the target 
audience and scope.  

2 Author outlines and plans chapters and sections. Author may enlist assistance 
of the MPCO Editing Unit when outlining and planning the report. 

3 Author writes draft of report.  

4 Author edits draft of report, adds cover and credits pages, creates table of 
contents, formats report using the CEC style template, and checks for 
accessibility in Microsoft Word. 

5 Author sends draft of report to office manager (and peers) for first review.  

http://energynet/Exec/doc_production/templates/
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Step 
Number 

Review Step 

6 Office manager adds comments and suggestions.  

(Note: Report will probably go between the author and the manager or 
colleagues several times before finalized into a product to send out for 
review.) 

7 Author incorporates edits and comments into report. 

 

Table 4: Commissionwide Review Process Steps 

Step 
Number 

Review Step 

8 Author prepares CEC 5 Form to accompany report on sign-off route.  

9 Author sends report electronically to office manager for review and sign-off.  

10 Office manager sends report electronically and delivers folder containing the 
CEC 5 Form to MPCO for review and sign-off, respectively.  

11 After review for formatting, content, and ADA compliance, MPCO returns 
report electronically to author to incorporate edits. Author or designate 
retrieves the folder with the signed CEC Form 5. 

12 After incorporating edits, author sends report to division director for review. 

13 After review, division director sends report to Office of Governmental Affairs 
(OGA) for review. (Note: only if legislatively mandated document. If not, 
division director sends report to the lead commissioner.) 

14 Division director or OGA sends report to lead commissioner for review and 
sign-off.  
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Table 5: CEC Publishing Steps 

Step 
Number 

Publishing Step 

21 Author sends Word, PDF, graphics, and other files to Webmaster for posting 
on CEC website and archiving. 

22 Web Team: 

a. Assigns publication number to document. 
b. Checks Americans with Disabilities Act accessibility of document. 
c. Checks document properties. 
d. Adds report information to publications database. 
e. Codes final report HTML page for website, creates links from various pages 

to report.  
f. Puts report and graphic image of cover online. 

23 Webmaster sends PDF of final publication to Commission Library and 
Publications Unit. These are usually sent each month on a CD-ROM. 

24 Publications Unit prints master paper copy and prints limited number of 
inventory copies. 

25 Publications Unit sends printed copies to state depository libraries. 

26 Webmaster archives electronic version(s) of publication to be kept indefinitely.  

Report Sequencing 
Occasionally reports go through several steps or versions. They can move through the 
following steps, or they can start at step 3 and go to step 8:  

1. Draft Consultant Report  CEC-100-2020-001-DCR 
2. Final Consultant Report  CEC-100-2020-001-FCR 
3. Staff Draft Report  CEC-100-2020-001-SD 
4. Staff Final Report  CEC-100-2020-001-SF 
5. Committee Draft Report CEC-100-2020-001-CTD 
6. Committee Final Report  CEC-100-2020-001-CTF 
7. Commission Draft Report CEC-100-2020-001-CMD 
8. Commission Final or Adopted Report CEC-100-2020-001-CMF 
9. Revised Commission Final Report CEC-100-2020-001-CMF-REV 
 

Each type of report is considered a separate report for review and sign-off.  
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A report is not called “draft” when it is sent around for review. It is called a “draft” only if it is 
going to be published as a draft and a final report will be subsequently published. 
Furthermore, do not use the “DRAFT” watermark on CEC documents. 

Moreover, reports may also be revised and republished. In this instance, the MPCO will use the 
same publication number with a “-REV” suffix added. The publication date on the cover should 
say “Revised: Month Date, Year.” For example, if a final CEC-adopted report were to be 
revised, the number stack on the cover would read: 

CEC-100-2020-001-CMF-REV 
Revised: April 27, 2020 

The publication number assigned to a report in the above sequence remains the same 
throughout the entire sequence. The suffix added to the end of the publication number is 
changed at each step. The suffix is added when the report reaches MPCO for review and sign-
off. Examples are given above. 

If the report is part of such a sequence, please attach a note to the CEC 5 Form to inform 
MPCO of that fact so that a new publication number is not assigned in error. 

Project reports from the Fuel and Transportation Division’s Clean Transportation Program 
(CTP) often have addenda. To denote an addendum to a project report, the publication 
number may read, for example, “CEC-600-2020-001-AD1.” 

Errata and Additional Revisions to Reports 
Occasionally, a report needs small corrections because of typographical errors, or revisions are 
made after the report is published.  

If the errors are relatively minor, an errata sheet can be issued. The changes are physically 
made in the Word file of the document, a new PDF is created, and the publication number 
receives the suffix –ER[1]. (Use numbers if more than one erratum.) The MPCO also adds a 
PDF of the errata sheet to the original document so that original document contains the errata 
sheet as part of the PDF. 

If the report has major revisions, then the suffix –REV is added. Use -REV2, -REV3, and so 
forth if more than one revision. 
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Reproduction 
The CEC has additional procedures, beyond the review and publication process, for mass 
reproduction of documents. A total of 500 impressions or fewer (10 copies of 50 pages for 
example) may be duplicated using an office or division photocopier. For amounts greater than 
500 impressions, a reproduction order (Commission Form CEC-219) must be made with the 
Reprographic Unit in Business Services. Find more about Reproduction Services on EnergyNet 
at http://energynet.energy.state.ca.us/Admin/hrssb/Business%20Service/CopyCenter.html. 

  

http://energynet.energy.state.ca.us/Admin/hrssb/Business%20Service/CopyCenter.html
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CHAPTER 4:  
Parts, Contents, and General Formatting of 
Reports  

Report Sections 
As explained in Chapter 2, CEC reports contain the following sections, in the following order: 

• Cover page (required) 
• Credits page (required) with legal disclaimer (mandatory on committee and staff 

reports) on the reverse side of cover 
• Acknowledgements page (acknowledgements are optional) 
• Preface (optional) 
• Abstract, keywords, and citation page (required) 
• Table of contents (required, followed by list of figures and list of tables, if needed) 
• Executive summary (optional but required on policy documents) 
• Body of the report  
• References (if applicable) 
• Glossary/acronyms (If more than 10 acronyms or abbreviations are used, it is required. 

Term definitions are also required.) 
• Bibliography (if applicable) 
• Appendices (if applicable) (Create a separate volume if very large.) 
• Attachments (if applicable)  

This chapter will describe each report part, showing examples and explaining the processes 
involved in creating those sections. 

The three main Commission-authored reports—staff reports (including manuals), Lead 
Commissioner reports, and Commission reports—have the same cover but different credits 
pages. The credits pages of consultant and Energy Research and Development Division 
(ERDD) and CTP project reports also differ. Staff papers do not have a credits page.  
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Cover and Credits Pages for Energy Commission Reports 
Covers and credit pages for CEC reports use templates that are available from the Energy 
Commission “EnergyNet” Intranet website at 

http://energynet/Exec/doc_production/. 

Report templates are also available at the CEC’s website, http://www.energy.ca.gov. 

If you wish to create a report using a cover or font other than those sanctioned by 
the CEC, contact the director of communications and external affairs for an 
exception.  

Covers 
Do not put a page number on the cover. 

The required elements used on these covers are the: 

• CEC logo in the top left corner and the logo of the California Natural Resources Agency 
in the top right corner. 

• Title of the report. 
• Subtitle of report. (If not used, remove subtitle.) 
• Type of report (Staff, Lead Commissioner, Commission Draft/Final Report) 
• Governor’s name and title. 
• Month and year published. 
• Publication number. 

Titles concisely describe the report. Titles are in title case in Tahoma 29 pt., bold. Subheadings 
are in Tahoma 16 pt., normal, in gray. 

Do not use abbreviations or acronyms in the titles of reports. Spell them out. For example, if 
the report is about Assembly Bill 32, do not use “AB 32” in the report title. 

Report Credits Page  

Commission Report Credits Page 
The credits page of Commission reports is different from those of other reports in that there is 
no disclaimer on Commission reports. Commission reports also use the full commissioners’ 
names, referred to as a “stack.”  

The credits page is on the reverse side of the cover of the report. There is no blank page 
between the cover and credits pages. The credits are on the left-hand side of the page.  

The credits page of Commission and Commission-adopted reports requires the following parts 
all in Tahoma typeface: 

• Commission name in title case, 20 pt., bold 
• Commissioners stack in 12 pt. normal, which includes:  

http://energynet/Exec/doc_production/
http://energynet/Exec/doc_production/
https://www.energy.ca.gov/
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o Name of the chair. 
o Chair title below name in bold, followed by an additional return. 
o Vice chair name. 
o Vice chair title below name in bold, followed by additional return. 
o The word “Commissioners” in bold. 
o Listing of the other three commissioners by seniority rank. 
o Two line returns 

• Executive director name with title “Executive Director” below name in bold and title 
case 

• Name of primary author(s) with words “Primary Author(s)” below name in bold and title 
case. (If there are more than five authors, do not stack the names. Instead, put names 
with commas between but use only one half of the page width.) 

• Name of project manager (if applicable) with words “Project Manager” below in bold. 
• Name of office manager, with the title “Manager” in title case below, followed by name 

of office in bold and ALL CAPS below. 
• Name of division chief, followed by title “Deputy Director” in bold and title case below, 

followed by division name in bold and ALL CAPS. 
The credits page should be only one column long. If more space is required, please contact 
MPCO for direction.  

Do not put a page number on the cover. 

Reminder: Always double-check the spelling of all names and titles! 

Commissioner Stack for Other Printed Materials 
A similar Commissioner stack is required on all brochures, posters, and other printed materials 
the CEC produces (either in-house or externally) or that are produced under contract for the 
Commission. Those documents also require the governor’s name and the CEC logo. 

Lead Commissioner Report Credits Page 
A Lead Commissioner report uses the same cover as Commission report. Lead Commissioner 
report covers also are used for the presiding member proposed decision (PMPD) for power 
plant licensing cases, usually with an artist rendition of what the power plant will look like on 
the cover. 

Staff Report Credits Page 
The cover for CEC staff reports has the words “Staff Report” in the place where the type of 
report is placed. Covers and credit pages for Energy Commission staff reports use templates 
that are available from the CEC “EnergyNet” intranet website at 

http://energynet/Exec/doc_production/index.html. 
  

http://energynet/Exec/doc_production/index.html
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Consultant Reports Cover and Credits Pages 
The CEC occasionally hires outside contractors to help prepare various reports and other 
printed materials.  

The consultant report template is on the CEC website at 
https://www.energy.ca.gov/contracts/consultant_reports/index.html. 

Research and Development and Clean Transportation Program Project Reports 
Authors of ERDD and CTP project reports may use scientific numbering in the report headings, 
as long as the heading numbers are consistent. 

Although these reports may address science and technology, contractors write in a manner 
understood by a lay audience. Furthermore, the executive summary belongs to the lay reader 
(ratepayer, legislator, nonscientific executive, and so forth). Authors must write this section 
clearly and concisely with little or no jargon. 

Other Types of Commission Reports 
Other reports that the Commission publishes include draft and final versions (if applicable) of 
the following: 

• Guidebooks (staff, Lead Commissioner, Commission, draft, and final, where applicable) 
• Instructions (staff, Lead Commissioner, Commission, draft, and final, where applicable) 
• Manuals (staff, Lead Commissioner, Commission, draft, and final, where applicable) 
• Preliminary and final staff analysis or assessments (of power plant licensing cases) 
• Presiding member proposed decisions (of power plant licensing cases) 
• Regulations (including 15-day, 45-day, 60-day language, and final) 

 

These reports (and other types not mentioned here) use the standard Commission report 
cover template. Change the “type” of report on the front cover to the applicable type. Use the 
appropriate credits page with disclaimer (if non-Commission-adopted).  

Regulations, decisions, manuals, and guidebooks are publications that do not get the high-
level of editing and review as do regular CEC reports. They still must go through review 
and sign-off using a CEC 5 Form. Commission editors, however, know that the language of 
these publications is exact and must be left (in many cases) as it is written. That does not 
mean that writers should be careless in punctuation, grammar, and spelling. These documents 
should follow the formatting and content standards set forth in this Commission Style Manual. 

The only exception to the sign-off process and the need for a CEC 5 Form are power plant 
siting case reports. These are the preliminary and final staff assessments (PSAs and FSAs, 
respectively), the presiding member proposed decisions (PMPDs), and CEC final decisions. 
Siting Division office managers, the siting division chief, Office of the Chief Counsel, and the 
Hearing Office (where applicable) review and edit these reports. Usually they are not edited or 
reviewed by MPCO or the Executive Office. 

https://www.energy.ca.gov/funding-opportunities/funding-resources/formatting-reports-and-writing-style-consultants-california


29 
 

 

Publication Numbers 
All CEC external publications (reports, papers, presentations and speeches, brochures, flyers, 
handouts, fact sheets, CD-ROMs, and so forth) are assigned a publication number. 
Presentations given at workshops and hearings are not assigned a publication number unless a 
specific request is made.  

The format for publication numbers corresponds to American National Standard (ANS) Z39.23-
1997 for formatting and creating standard report numbers for technical reports. 

The format for publication numbers is:  

CEC – XXX – YEAR – XXX – suffix – format id. 

The parts of the publication number are:  

• The Commission identification with the ANS. 
• The division, office, or program area number for which the report was written. 
• The year the report is published. 
• The sequential number of the report for that division. 
• A suffix (if needed). 
• A format identification (such as -BR for brochure, -FS for fact sheet, -CD, -DVD).  

A hyphen is used between each part. 

The Web Team assigns the publication number for each document before posting to the CEC 
website. 

Suffixes at End of Publication Numbers 
The MPCO adds suffixes to the end of the publication number only if necessary to differentiate 
various versions, volumes, editions, or parts of the same document. The suffix is preceded by 
a hyphen. 

Other Report Sections 
Acknowledgements Page (Optional) 
This page comes after the credits page and precedes the preface page. Page numbering 
begins on this page with lowercase Roman numerals (i, ii, iii, iv, v, and so forth).  

What Are Acknowledgements?  
Acknowledgements express appreciation by the authors or committee members to those who 
participated in the gathering of information for or the writing of the report. It may be a 
paragraph, bulleted list, or columns of names and, if appropriate, their affiliations. 
Acknowledgements are optional.  
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Preface Page (Optional) 
This page comes after the credits page and acknowledgements (if used) and precedes the 
abstract page. Page numbering begins on this page with lowercase Roman numerals (i, ii, iii, 
iv, v, vi, etc.) if it did not begin on the acknowledgements page. 

The preface is an introduction to the report generally explaining the subject, scope, or aim. If 
the report is legally or legislatively required, the preface states the law or mandate that 
dictates that the report be completed. 

Abstract, Keywords, and Citation Page (Mandatory) 
The abstract, keywords, and citation have been gathered together on one page—the abstract 
page. Below is an example. 

Figure 3: Example of Abstract/Keyword/Citation Page 

 
Source: California Energy Commission, Media and Public Communications Office 

 

Abstract 
All CEC reports are required to have a short abstract. This concise, informative summary of the 
report should be no more than 300 words, single-spaced. 

The abstract should clearly address the report purpose, scope, methods, and major findings, 
including the report results, conclusions, and recommendations.  
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Abstracting services publish abstracts to help readers determine whether a report is targeted 
to their area of interest; therefore, it should be understandable as a stand-alone document. 
The abstract should not contain undefined symbols, abbreviations, or acronyms and should not 
refer to specific elements of the main report. It should not refer to other reports unless it is 
essential to clarify the document purpose. Do not include citations within the abstract. 

Place the abstract on an odd-numbered, right-hand-facing page. 

Keywords 
The abstract page must contain five or more keywords that will help search engines and other 
databases find the report subject matter. The keywords should be listed separately and spaced 
about five lines below the end of the abstract. Separate each word by comma—followed by a 
space—with no ending punctuation. For example: 

Keywords: California, solar, energy, photovoltaic, PV, cell, panel, building, integrated, BIPV, 
electricity production, distributed generation, initiative, CSI, emerging, renewables, program, 
rebate 

Citation Information  
Citations are now included in the abstract page. 

It is mandatory to include a citation for your report in the following style: 

• Author last name, author first name (or initial). Note: If there are multiple authors, list 
with chief author name first, or list alphabetically. The first name in the series should 
have the last name followed by first name; all subsequent authors have the first name, 
then the last name. Use commas between authors’ names.  

• Year of publication 
• Report title in italics 
• California Energy Commission (as publisher) 
• CEC publication number  

Citation Example: 
Wolman, H., R. E. Moon (Engineering International). 2007. Widgets and More. California 

Energy Commission. Publication Number: CEC-500-2006-987. (That is, Woolman and 
Moon work for Engineering International, so this optional method of listing authors 
incorporates the authors and the company for which they work.) 

Additional Examples: 
Aldrich, Bob, Susanne Garfield-Jones, Margaret Larkin, Lana McAllister, Carol Robinson, and 

Michael Wilson. 2015. Style Manual: Third Edition: Used for California Energy 
Commission Staff, Lead Commissioner, and Commission Reports, Presentations, and 
Papers. California Energy Commission, Media and Public Communications Office. 
Publication Number: CEC-180-2015-002. 
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Burt, Charles and Darren Cordova (Irrigation Training and Research Center, California 
Polytechnic State University). 2002. Electric Load Shifting in Irrigation Districts – 
California Program. California Energy Commission. CEC-400-2002-002. 

Unnasch, Stefan and Michael Chan (TIAX, LLC). 2007. Full-Fuel-Cycle Assessment: Tank-to-
Wheels Emissions and Energy Consumption. California Energy Commission. Publication 
Number: CEC-600-2007-003.  

Table of Contents 
Include the following sections in the table of contents:  

• Acknowledgement (optional) 
• Preface (optional) 
• Abstract, keywords, and citation (required) 
• Executive summary (required in all consultant reports and policy reports) 
• Chapter number and title followed by subheadings using the following format: 

 
Chapter 1: Chapter Title in Title Case (Heading 2) 

o Subheading (Heading 3) 
 Sub-subheading (Heading 4) 

- Sub-sub-subheading (Heading 5) 
• Appendices (if applicable) (Enter appendix letters and titles in the table of contents 

manually.) 
• Attachments (if applicable) (Enter attachment numbers and titles in the table of 

contents manually.) 
Generate the table of contents using the Microsoft Word automated feature. To do so, go to 
Insert > Reference > Index and Tables > Table of Contents > OK. Add at least two levels of 
heads (no more than three) under the table of contents to help the reader know the contents 
of the chapters. 

Following the table of contents, generate the list of figures and the list of tables, if needed, 
using Word automated features. To do so, go to Insert > Reference > Index and Tables > 
Table of Figures. Under “Caption Label” choose either Figure or Table, then in Options, Style, 
choose "Figure caption" (for a figure) or “Table caption” (for a table) > OK. 

Update the table of contents, list of figures, and list of tables after all editing has been 
completed and proofread to ensure that the entries are complete and correct. (The Microsoft 
Word automatic table of contents feature, while useful, is not perfect and can occasionally 
miscreate entries.) The appendix and attachment listings must be entered by hand. Do not 
provide page numbers for appendices or attachments. 

The table of contents should use a right-hand tab, set at 6.5 inches, with a dot leader for the 
page numbers. Set other tabs (for subheading and sub-subheadings) at 0.25 and 0.50 inch. 
Break long titles using a soft return (shift-enter) and a hanging indent. 
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Figure 4: Example of Table of Contents 

 

  Source: California Energy Commission, Media and Public Communications Office 

Executive Summary 
The executive summary is a final report in miniature, containing all the key information. It 
summarizes the report and should include the following headings: 

• Introduction or Background 
• Purpose (outlining the broad purpose) 
• Objectives (if appropriate) 
• Conclusions or Recommendations or both 

These subheadings should appear in the table of contents.  

The executive summary is intended to be short (preferred length is 2–10 pages). It can use a 
succinct, bulleted format to summarize the pertinent points under each of these sections or 
can be more conversational. Assume a nontechnical, management-level readership.  

The introduction summarizes the purpose of the report. An introduction should give the 
relevant background and overview. It should define the issue or problem being addressed by 
the report. If the author uses jargon, the jargon must be defined at a lay reader’s level.  

As a report summary, the executive summary should not present new information not found in 
the main document. The executive summary should not just repeat the abstract.  

Do not cite references in the executive summary, and with rare exceptions, do not use 
acronyms or abbreviations. Do not use mathematical symbols or equations in the executive 
summary. 
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The executive summary heading uses the same “ALL CAPS” style that is used on preface and 
abstract titles. 

The executive summary marks the division between front matter, using lowercase Roman 
numeral pagination, and the body of the report. Thus, the first page of the executive summary 
will always be page 1 (Arabic numbering) of the report. 

Chapters and Section Headings 
Chapters should be numbered (CHAPTER 1:, CHAPTER 2:, and so forth in upper case) followed 
by a colon, a shift-return (soft return), and then the chapter title in title case.  

Use a soft return again [shift-return] if you need to break the title into two lines. Try not to 
leave orphaned words. Instead, use a soft return to group words. 

You do not need to capitalize the following words, unless they begin the title or a second line:  

a an and by for or the 

Example: 

CHAPTER 1: How You Should Create Excellent Titles for Commission Reports 

The example above is awkward because it orphans the word “Reports.” Break the line (with 
shift>return) to group common words together: 

Good: 
  CHAPTER 1: 
  How You Should Create Excellent Titles 
  For Commission Reports 

Better: 
  CHAPTER 1: 
  How You Should Create 
  Excellent Titles for Commission Reports 

Best: 

  CHAPTER 1: 
  Creating Excellent Titles for Commission Reports 

 

The example marked “Better” uses a stepped format that is more pleasing to the eye, but the 
example marked “Best” is cleaner and reads better. 

Chapter 1 should begin on an odd-numbered page. Subsequent chapters may begin on either 
an odd- or even-numbered page. Chapter headings go at the top of the page. 

Only ERDD and CTP project reports may use scientific or technical section numbering (Section 
1.1, Section 2.1.6). If scientific numbering is used, it must be used for all headings throughout 
the report, not just the first heading. 
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References 
The references section at the end of the report must list all documents cited in the body of the 
report. List references in a standard alphabetical format. Use the section title font for 
“References” and the Tahoma 12 pt. regular text font for each citation. Please check that 
references contained in the report body are accurate and that the full citation for each 
reference is listed in the references section. 

Titles of reports, books, and periodicals are in italics. Titles of chapters, articles, fact sheets, 
brochures, and Web pages are enclosed in quotation marks without italics.  

Please provide the year after the name of the authors and, if available, organization that 
produced the document. If the month is available, provide that as well. Please hyperlink the 
title of the article or report, followed by the deactivated URL.  

Examples: 

Melaina, Marc, Ethan Warner, Yongling Sun, Emily Newes, and Adam Ragatz (National 
Renewable Energy Laboratory). 2014. Program Benefits Guidance: Analysis of Benefits 
Associated With Projects and Technologies Supported by the Alternative and Renewable Fuel 
and Vehicle Technology Program. CEC-600-2014-005-D. Available at 
http://www.energy.ca.gov/2014publications/CEC-600-2014-005/CEC-600-2014-005-D.pdf.   

California Energy Commission staff. 2017 Integrated Energy Policy Report. February 2018. 
Publication Number: CEC-100-2017-001-CMF. Available at 
https://efiling.energy.ca.gov/getdocument.aspx?tn=223205. 
See “Citation Information” subsection on page 33 of this style manual for more examples. 

Glossary 
To help readers understand Commission reports, provide a glossary with a definition for each 
term, acronym or abbreviation, or both. Use the Microsoft Word table feature to create a two-
column format with the acronym or abbreviation and the spelled-out term in the left column 
and the definition in the right column. Designate a header row with “Term” in one column and 
“Definition” in the other. 

Bibliography 
A bibliography includes references used in preparing the report that are not cited therein. This 
section is optional. If used, consult the same reference books mentioned in the references 
section, above, for formatting guidance.  
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CHAPTER 5: 
Appendices and Attachments 

An appendix is usually supplementary material produced by the report author. An attachment 
is usually supplementary material produced by someone other than the author.  

Important Note About Copyrights and Permissions 
If an attachment or an appendix has been previously published, the author must obtain 
written permission from the copyright holder before the CEC can republish or put that 
document online. 

You should ask for “written permission for electronic publishing of the document in Adobe 
Acrobat PDF format on the CEC website.”  

Most previously published documents will be posted as separate files with the respective cover 
pages. No credits page is needed for an appendix or attachment not funded by the CEC. On 
the cover page where the words “Prepared by” are, please include the following statement: 

Please note: This document is an attachment to a report prepared/funded by the California 
Energy Commission (CEC). The CEC did not prepare or fund this attachment, but the author(s) 
has/have requested it be available as a supporting document. 

The CEC wishes to thank the copyright holder, [fi ll in name of author or publisher or 
whomever holds the copyright or a combination], for permission to republish this 
document in electronic format on the CEC website.  

Please contact the original author/publisher for additional information about the document at 
[fill in company website address, phone number, or email address]. 

Appendices 
An appendix is supplementary material usually produced by the report author(s). Designate 
appendices by capital letters (Appendix A, Appendix B, Appendix C, and so forth), not 
numbers.  

The body of the report needs to refer clearly to the attached appendix. References in the main 
report to information contained in the appendix should indicate the specific page or section of 
the appendix, not just a general reference to “Appendix D.” The report should also explain 
how the material in the appendices matters to the text. If it does not matter, the appendix 
probably should be dropped. 
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Formatting and Editing of Appendices 
Appendices should use the same CEC-required formatting and style as the main report. If an 
appendix was previously published using a different style and format, that organization or 
other agency style and format does not necessarily need to be changed. Please contact MPCO 
for directions on appendices that were previously written.  

The content and format of an appendix are subject to editing just like the report itself. 

If small enough, appendices will usually be a part of the actual report. An appendix cover page 
should appear like what appears in Figure 5 on the next page.  

Each appendix must have a cover page and publication number. If the CEC funded the work, 
each appendix must also have a credits page. The Web Team provides the publication number 
before the report is posted online  

If the appendix has been previously published by another organization or agency with a 
different cover, it receives a CEC cover page but no credits page. If the work contained in the 
appendix was not funded by the CEC, be sure the cover page contains the boilerplate 
copyright permission language provided earlier in the “Copyrights and Permissions” section. 

Appendices Publication Numbers 
The publication number of an appendix consists of the main report publication number plus a 
suffix. If there is only one appendix, the suffix is –AP. If there are multiple appendices, the 
suffixes are -APA, -APB, -APC, and so forth, depending on the letter of the appendix. 
Therefore, the publication number for Appendix B of a fictitious report published in 2020 by 
the Efficiency Division would be CEC-400-2020-987-APB.  

If multiple appendices are combined in one volume, then the suffix is only -AP with no 
additional letter. 

Page Numbering of Appendices 
Page numbering of appendices should include the letter of the appendix followed a hyphen 
and then by the page number. The same conventions of page numbering used in regular 
reports is also used in appendices. 

Example of page numbering: A-1, A-2, A-3; B-1, B-2, B-3; and so forth. 
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Appendices as Part of the Main Report 
If the appendices are short enough, they may be included in the same Word file as the main 
report. The first page of each appendix should be a title page, containing the following 
information:  

• The word “Appendix” (with letter A, B, or C, and so on if more than one appendix) in 
Tahoma 20 pt., bold, upper case. 

• Title of appendix, in Tahoma 20 pt., bold, title case. Use a soft return for the following 
line. 

• A-1, A-2, A-3, and so on (or B-1, C-1, and so on), page numbering centered on the 
bottom of the page. Use Arabic numerals. 

Figure 5 shows the format of what appendix title page could look like.  

Figure 5: Example of Appendix as Part of Main Report 

 

Source: Microsoft Word 2016 
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Appendices as Documents Separate From the Main Report 
If the Word file created by an appendix is too large (more than 5.0 megabytes), treat it as a 
separate volume from the main report.  

Where the appendix would normally go in the main report, insert a “slip sheet” that lists the 
following information: 

• Appendix A (or B or C, and so forth), in Tahoma 20 pt. bold, ALL CAPS, then two 
returns 

• Title of appendix, in Title Case, Tahoma 20 pt., bold  
• Text on the slip sheet saying: “This appendix is available as a separate volume, 

Publication Number CEC-XXX-YEAR-XXX-APX”  
• The slip sheet has no visible page number 

Please see Figure 6 for an example of a slip sheet for a single appendix that is a separate 
volume. 

If there is more than one appendix, the titles of each appendix should be listed on a single slip 
sheet. The title of the page, in that case, should be “Appendices” (Tahoma 20 pt., bold) with 
the appendix letters and titles, and the associated publication number(s), neatly arranged as a 
list. Please see Figure 6 for an example of multiple appendices listed on a “slip sheet.” 

If you have multiple small appendices, they may be combined into a single volume if the file 
size permits. If the multiple appendices create a file larger than five megabytes, then separate 
volumes should be created for each appendix. Appendices are posted online in Adobe Acrobat 
PDF format. (The example uses the previous font for display only. Please use Tahoma font for 
regular text and headings.) 
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Figure 6: Example of a "Slip Sheet" for Appendices 

 

Source: California Energy Commission, Media and Public Communications Office 

Appearance in Table of Contents 
When preparing the table of contents for the report, you may need to enter each appendix 
letter and title (or attachment number and title) manually into the table of contents. Contents 
of the appendix, however, are generally not included within the table of contents. 

Attachments 
Attachments are supporting documents that usually were not written by the author of the 
main report. An attachment may also be supplementary material that may not directly relate 
to the report. For example, attachments can include a collection of news articles that appeared 
on a certain topic.  
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Attachments are designated with Roman numerals rather than letters (Attachment I, 
Attachment II, and so forth). 

Most previously published documents will be posted as separate files, with the respective 
cover pages. No credits page is needed for an appendix or attachment not funded by the 
Energy Commission. On the cover page where the words “Prepared By” are located, please 
include the following statement: 

Please Note: This document is an attachment to a report prepared/funded by the California 
Energy Commission. The Energy Commission did not prepare or fund this attachment, but the 
author(s) has/have requested it be available as a supporting document. 

The Energy Commission wishes to thank the copyright holder, [fi ll in name of author or 
publisher or whoever holds the copyright or a combination], for permission to 
republish this document in electronic format on the Commission website.  

Please contact the original author/publisher for additional information about the document at 
[fill in company website address, phone number, or email address]. 
Attachments are usually published separately from the main report. Prepare a slip sheet and 
cover page(s) the same way as for appendices. Also include the attachment information in the 
report table of contents.  

The Web Team will assign a publication number to each attachment just before publication on 
the CEC website. The publication number of an attachment consists of the main report 
publication number plus a suffix. If there is only one attachment, the suffix is –AT. If there are 
multiple appendices, the suffixes are -ATI, -ATII, and so on, depending on the letter of the 
attachment. Therefore, the publication number for Attachment II of the same fictitious report 
published in 2020 by the Efficiency Division would be CEC-400-2020-987-ATII.  

In almost all cases, attachments will require permission to publish from the copyright holder. It 
is the report author’s responsibility to obtain this permission. You should ask the author or 
publisher for “written permission for electronic publishing of the document in Adobe Acrobat 
PDF format on the California Energy Commission website.” Make sure there is no time limit on 
the permission. 

The permission language appears on the cover of the attachment in a box like the one below. 
Send a photocopy of the written permission you have obtained to the Webmaster when you 
deliver the report and the appendices or attachments. A copy of the written permission should 
be given the MPCO.  
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CHAPTER 6: 
Document Accessibility for Energy Commission 
Reports  

What Is Document Accessibility? 
Under state and federal laws and policies, the CEC is responsible for ensuring that its website 
and written content, including electronic documents, are accessible to people with disabilities.  

Disabilities listed include: 

• Blindness. 
• Cognitive disabilities. 
• Color blindness. 
• Developmental disabilities. 
• Hearing impairments. 
• Manual dexterity limitations.  
• Seizure disorders. 
• Speech difficulties.4 

The CEC uses accessible Microsoft Word report templates to make reports accessible to all 
readers. The MPCO and the Web Team run the accessibility checker to ensure the reports 
meet accessibility requirements before they are posted online. 

Seven Principles to Creating an Accessible Word Document 
The California Department of Rehabilitation’s Disability Access Services outlines seven basic 
principles for accessibility: 

1. Font style and size 
2. Appropriate use of color 
3. Alternative text 
4. Simple tables with header rows 
5. Meaningful hyperlinks 
6. Built-in styles and designs 
7. Accessibility testing5 

                                        

 
4 California Energy Commission. November 2019. Web Accessibility, 
http://energynet/Exec/documents/web_accessibility_guidelines.pdf. 

5 California Department of Rehabilitation, Disability Access Services. Resources for Creating Accessible Content, 
https://www.dor.ca.gov/Home/ResourcesforCreatingAccessibleContent. 

http://energynet/Exec/documents/web_accessibility_guidelines.pdf
https://www.dor.ca.gov/Home/ResourcesforCreatingAccessibleContent
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Step One: Font Style and Size 
The Department of Rehabilitation’s Disability Access Services recommends using sans-serif 
fonts because they are visually easier to read.6  

“Sans serif” means without the decorative line. Examples include Arial and Tahoma. 

For reports, the CEC templates use the Tahoma 12-pt. sans-serif font for regular text. The CEC 
also uses Tahoma for all headings, titles of graphics, and related source lines. 

Step Two: Appropriate Use of Color 
Color contrast between text and background on Web pages is important because it affects 
some people’s ability to perceive the information visually.7 

When creating CEC reports, ensure that the text and background have a sufficiently high level 
of contrast. Report writers can check for contrast using a color contrast analyzer. CEC staff 
members should have the application installed on their computers. If not, contact the IT Help 
Desk to have the analyzer installed. 

  

                                        

 
 

6 Ibid. 

7 Morton, Richard. June 2016. “Accessibility in Government: Colour Contrast—Why Does It Matter?” (blog), 
Gov.UK, https://accessibility.blog.gov.uk/2016/06/17/colour-contrast-why-does-it-matter/. 

 

https://accessibility.blog.gov.uk/2016/06/17/colour-contrast-why-does-it-matter/
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Figure 7: Colour Contrast Analyzer 

 

Source: The Paciello Group 

Testing for Color Contrast 
To test a graphic for enough color contrast: 

• Click on the top eyedropper under “foreground colour.” A hollow circle will appear. 
• Move the hollow circle over the color of the text, shape, or line to be tested. Click on 

that color. 
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• Next, click on the eyedropper icon under “background colour.” Hover the hollow circle 
over the background of the text, shape, or line previously tested. Click on the 
background. 

• Under Web Content Accessibility Guidelines (WCAG) 2.1 results, the color contrast 
should meet the minimum “AA” standard or better.  

Tips for Using Color in Graphics 
Graphics are an integral part of CEC reports. In its color contrast tutorial, Michigan State 
University recommends the following guidelines:8 

• Use an appropriate chart type. For example, occurrences of things over time probably 
should be depicted by a line chart, while comparisons at a point in time might be better 
depicted in a bar graph and percentages as a pie chart. 

• Use hatching (sometimes called “textures”) instead of or, with proper contrast, in 
addition to colors in graphs and charts. 

• Avoid using red, green, and orange together or in combinations on a graphic, and avoid 
red on black or black on red. 

• Draw attention to important information in graphics by circling it rather than changing 
the color. 

• Use high-contrast colors. 
• If possible, label lines and pie slices directly; otherwise, have a clear key or lines that 

show which labels belong to what. 
• Be sure chart keys and labeling follow proper conventions (left to right, top to bottom, 

clockwise). 
• Be sure chart keys and symbols are large enough to be distinguished clearly on high-

density screens. 
• For line data points, use distinct marks such as triangles, squares, discs on each line, 

distinct line styles, dashes, dots, or combinations thereof. 
• Include the data in an accessible table below the chart when that is needed for fullest 

inclusion. 
  

                                        

 
8 Michigan State University. Color Contrast Tutorial, https://webaccess.msu.edu/Tutorials/color-
contrast.html#using. 

 

https://caenergy-my.sharepoint.com/personal/carol_robinson_energy_ca_gov/Documents/Archive/leftovers/Color%20Contrast%20Tutorial,
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Table 6: Example of Use of Color and Nonredundant Symbols 
Report Title Review Date Completed 

2019 IEPR January 3, 2020 N 

2019-2020 Clean 
Transportation Report 

November 20, 2019 Y 

2020 Commission Style 
Manual 

January 8, 2020 N 

Source: California Energy Commission 
The figures are examples of two pie charts. In the first pie chart, the contrast fails on all but 
two adjacent colors. Moreover, a text box encloses the chart. In the second chart, each slice is 
labeled, and the text is larger and bolder with higher contrast than the AAA requirements. 

When developing reports using color to distinguish among options, always provide a 
redundant element, like a differing symbol, to allow for understanding.9 

Figure 8: Incorrect Contrast Pie Chart Example 

 

Source: Michigan State University 
  
                                        

 
9 Ibid. 
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Figure 9: Final Pie Chart 

 

Source: Michigan State University 

Step Three: Add Alternative Texts and Captions 
Many graphics included in CEC reports need alt text and captions. Without alt text and 
captions, these images will not be perceived or properly understood by people with visual 
disabilities. 

Screen readers “read” alt text and captions, allowing the content and function of these images 
to be accessible to people with visual or certain cognitive disabilities.10 

To add alt text using the mouse, right click (or Shift + F10) on the image and select “Format 
Picture.” A panel will appear on the right side. Choose the third icon that looks like a dark box 
titled “Layout & Properties.” When the drop-down menu appears, choose “Alt Text.” 
  

                                        

 
10 California Department of Rehabilitation, Disability Access Services. June 2019. Seven Steps to Creating an 
Accessible Microsoft Word Document, 
https://www.dor.ca.gov/Content/DorIncludes/documents/DisabilityAccessServices/Seven%20Steps%20to%20Cre
ating%20an%20Accessible%20Word%20document%206%202019%20.pdf. 

 

https://www.dor.ca.gov/Content/DorIncludes/documents/DisabilityAccessServices/Seven%20Steps%20to%20Creating%20an%20Accessible%20Word%20document%206%202019%20.pdf
https://www.dor.ca.gov/Content/DorIncludes/documents/DisabilityAccessServices/Seven%20Steps%20to%20Creating%20an%20Accessible%20Word%20document%206%202019%20.pdf
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Figure 10: Format Picture 

 

Source: IT Support Guides 

Under “Title,” type the title of the graphic, which should be short. In the “Description” box, 
describe the type of graphic, such as “a pie chart displaying the distribution of pie types.” If 
the graph information is not displayed elsewhere in the document, then it needs to be 
described in the alt text. 
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Figure 11: Describing Graphic Using Alt Text 

 

Source: IT Support Guides 

Wrapping Text With a Graphic 
When adding an image or graphic, always set the wrapping style to “In Line With Text.” 
According to Disability Access Services, text that wraps around an image will often confuse a 
screen reader, making it difficult for the user to understand. 

Right click (or Shift + F10) the image and select “Text Wrapping,” then chose “In Line With 
Text.” 

Step Four: Construct Simple Tables 
When constructing simple tables: 

• Use only one row in the header. 
• Never merge or split cells 
• Try not to leave any cells, rows, or columns blank. 

To create a simple, accessible table:11 

1. Select the “Insert” tab and click on the “Table” menu. 
2. Select the number of rows and columns by either: 

                                        

 
11 Ibid. 
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a. Using the cursor. Start at the top of the grid and drag the mouse to include all 
the columns and rows wanted. 

b. Navigating the keyboard—Alt, N, T, and then use arrows to choose the number 
of rows and columns. Press “Enter” to insert table. 

Once the table has been created and populated with data, identify a “header row” to allow the 
heading text to be distinguished from the data area of the table.  

1. Select the first row of the table. Right click (Shift + F10) for context menu. Choose 
“Table Properties,” followed by the “Row” tab. 

2. Ensure the option “Allow row to break across pages” is unchecked. Check “Repeat as 
header row at the top of each page” is checked. 

3. Select “OK.” 

Figure 12: Table Properties 

 

Source: Microsoft Word 2016 

Simple tables make it easier for someone using assistive technologies to understand the table. 
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Step Five: Use Meaningful Hyperlink Text 
Hyperlinked text should describe clearly the link destination. One of the ways a person using 
assistive technologies can navigate a document is by skipping from hyperlink to hyperlink or 
by pulling up a list of all the links in a document (Insert + F7).12 When a screen reader reads 
text and there is a link, the software will insert the word “link” in front of the text to alert the 
user that this is a selectable hyperlink.13 Therefore, using phrases like “click here” or “visit” are 
not sufficient because they do not provide enough meaning. 

Here are some examples: 

• Wrong: The 2018 IEPR Update, Volume II, can be accessed here. 
• Wrong: The 2018 IEPR Update, Volume II, can be accessed at 

https://ww2.energy.ca.gov/2018publications/CEC-100-2018-001/CEC-100-2018-001-V2-
CMF.pdf. 

• Right: The 2018 IEPR Update, Volume II, is available at 
(https://ww2.energy.ca.gov/2018publications/CEC-100-2018-001/CEC-100-2018-001-
V2-CMF.pdf). 

To add a hyperlink to a document: 

1. Place the cursor where the hyperlink is to appear or simply highlight the text in the 
document that is to become a link. 

2. In the “Insert” tab, click on “Hyperlink” (Alt, N, I), and a dialog box will open. 
3. In the “Text to Display” box, type the name or phrase that briefly describes the link 

destination. (If text was highlighted, this box will already be filled.) 
4. Choose to enter either a URL, a location within the same document, an email address, 

or a link to another document. 
5. Type or copy it into the “Address box.” Click “OK.” 

When creating a footnote, add the hyperlink for the citation, as well as the URL. To deactivate 
the URL, place the cursor immediately to the right of the URL and press “Backspace.” (See any 
hyperlinked footnote in this style manual for an example.) 

  

                                        

 
12 Ibid. 

13 Social Security Administration, Accessibility Resource Center. April 2010. SSA Guide: Producing Accessible 
Word and PDF Documents, Version 2.1, 
https://www.ssa.gov/accessibility/files/The_Social_Security_Administration_Accessible_Document_Authoring_Gui
de_2.1.2.pdf. 

https://ww2.energy.ca.gov/2018publications/CEC-100-2018-001/CEC-100-2018-001-V2-CMF.pdf
https://ww2.energy.ca.gov/2018publications/CEC-100-2018-001/CEC-100-2018-001-V2-CMF.pdf
https://www.ssa.gov/accessibility/files/The_Social_Security_Administration_Accessible_Document_Authoring_Guide_2.1.2.pdf
https://www.ssa.gov/accessibility/files/The_Social_Security_Administration_Accessible_Document_Authoring_Guide_2.1.2.pdf
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Step Six: Use Built-In Formatting Styles 
Built-in formatting styles may be the most important step in making documents accessible. 
Built-in formatting styles provide a logical reading order that serves as a navigation guide for 
people using assistive technologies.14 

The CEC’s report templates are ADA-accessible. Templates for staff reports, staff papers, 
consultant reports, Lead Commissioner reports, commission reports, Clean Transportation 
Program final project reports, and Energy Research and Development Division final project 
reports are available on the Document Production and Notices pages of the EnergyNet 
intranet. Consultants who work outside the Commission may obtain a copy of the template 
from the contract manager for their project.  

If preparing a report from scratch, use the styles pane for managing and controlling multiple 
styles. 

Do not skip headings. Screen reader users can quickly navigate through the document using 
the headings, and skipping headings can confuse screen readers. 

Heading 1 is used only once for the cover title. All other headings are from 2 through 6. 

Step Seven: Check Accessibility 
Use the following methods to check document accessibility: 

• Use the Microsoft Word or Adobe Acrobat accessibility checker.  
• For reading order, use a screen reader, such as Nonvisual Desktop Access (NVDA), Jobs 

Access with Speech (JAWS), or Window-Eyes. 

To access the accessibility checker in Microsoft Word 2010, click the “File” tab of the 
document, click “Info,” “Check for Issues,” and then “Check Accessibility.” If navigating by 
keyboard, press Alt, F, I, I. 

In Adobe Acrobat, use the action wizard and accessibility tool. 

Screen readers are software programs that allow blind or visually impaired users to read the 
text displayed on the computer screen using a speech synthesizer or braille display. The user 
sends commands by pressing different combinations of keys on the computer keyboard or 
braille display to instruct the speech synthesizer what to say and to speak automatically when 
changes occur on the computer screen.15 

                                        

 
14 California Department of Rehabilitation, Disability Access Services. June 2019. Seven Steps to Creating an 
Accessible Microsoft Word Document, 
https://www.dor.ca.gov/Content/DorIncludes/documents/DisabilityAccessServices/Seven%20Steps%20to%20Cre
ating%20an%20Accessible%20Word%20document%206%202019%20.pdf.  

15 American Foundation for the Blind. 2019. Screen Readers, https://www.afb.org/blindness-and-low-
vision/using-technology/assistive-technology-products/screen-readers. 

https://www.dor.ca.gov/Content/DorIncludes/documents/DisabilityAccessServices/Seven%20Steps%20to%20Creating%20an%20Accessible%20Word%20document%206%202019%20.pdf
https://www.dor.ca.gov/Content/DorIncludes/documents/DisabilityAccessServices/Seven%20Steps%20to%20Creating%20an%20Accessible%20Word%20document%206%202019%20.pdf
https://caenergy-my.sharepoint.com/personal/carol_robinson_energy_ca_gov/Documents/Archive/leftovers/Screen%20Readers,
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CEC staff members should have the NVDA screen reader on their computers. If not, contact 
the IT Help Desk to have the application installed. 

Roles and Responsibilities 
CEC divisions and offices are responsible for ensuring that the reports they create are ADA-
accessible before sending them to the MPCO for review and the Web Team for posting online. 
Ensuring document accessibility means checking for accessibility for Microsoft Word and Adobe 
Acrobat Pro® PDF documents. Instructions for creating and verifying PDF accessibility are 
available on the Adobe website.16 

If a contractor created a report for the CEC, they must make the document accessible. 
Ultimately, the division or office is responsible. 

Document Accessibility Resources 
The CEC has an intranet page on “Document Accessibility Frequently Asked Questions,” which 
includes links to “Web Accessibility Guidelines” and “Web Content Review and Archive 
Guidelines” under the icon “Document Production and Notices.” 

Other resources include: 

• Disability Access Services, California Department of Rehabilitation, 
http://www.dor.ca.gov/Home/DisabilityAccessServices. 

• Web Accessibility, California Energy Commission website guidelines, 
http://energynet/Exec/documents/web_accessibility_guidelines.pdf. 

• Document Accessibility, California Department of Rehabilitation, 
https://www.dor.ca.gov/Home/DocumentAccessibility. 

• State of California Web Accessibility Toolkit, https://www.dor.ca.gov/Home/AB434. 
• Web Accessibility in Mind, https://webaim.org/. 
• Americans With Disabilities Act, https://www.ada.gov/. 

  

                                        

 
 

16 Adobe. December 2019. Create and Verify PDF Accessibility (Acrobat Pro), 
https://helpx.adobe.com/acrobat/using/create-verify-pdf-accessibility.html#make_PDFs_accessible. 

 

https://helpx.adobe.com/acrobat/using/create-verify-pdf-accessibility.html#make_PDFs_accessible
http://energynet/Exec/documents/document_accessibility_faq.html
http://energynet/Exec/doc_production/index.html
https://www.dor.ca.gov/Home/DisabilityAccessServices
http://energynet/Exec/documents/web_accessibility_guidelines.pdf
https://www.dor.ca.gov/Home/DocumentAccessibility
https://www.dor.ca.gov/Home/AB434
https://webaim.org/
https://www.ada.gov/
https://helpx.adobe.com/acrobat/using/create-verify-pdf-accessibility.html
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CHAPTER 7:  
Preparing Accurate, Consistent Reports 
and Report Content Styles 

Before you begin writing, put on the hat of an inquisitive, reasonably educated lay reader. 
Pretend that he or she paid for this report and wants to understand how and why you spent 
taxpayers’ money creating it. That is your intended audience. Even though colleagues in the 
energy industry may be the only people who read your report, you need to make the writing 
clear and understandable to a larger audience. Your reader may not speak or read English as a 
first language. So, you must write clearly and concisely.  

Here are some suggestions to keep in mind as you write the report:  

• Apply the test of completeness. Are all the pieces there? Are all the references clear, 
and do those in the text match those in the reference section? Are the relationships 
between the partners and the players clearly explained?  

• Apply the test of logic. Does the document flow and make sense? Is the need for the 
research clearly described? Is the technical approach clearly described? Do the 
conclusions make sense? Are they drawn from the analysis? Do the numbers check? Is 
it clear how the numbers were derived?  

• Analyze data that you present in the report. If you present a picture, graph, or table, be 
sure that you discuss it in the text; do not just refer to it.  

• Make sure you substantiate each conclusion by the analysis contained in the report.  
• Figures and tables must clearly relate to and be consistent with the text, and vice versa. 

(If the text says the generator had a capacity of 30 megawatts, the table should not 
say it was 31.2 megawatts.)  

• Use consistent references to report performance specifications and results. For 
example, if you refer to a piece of equipment by the nominal nameplate rating, then 
use that reference consistently throughout the report. If, however, the desired number 
was the measured performance of the device (usually different from nameplate), then 
consistently use that measured number. Do not mix the two in the narrative.  

• The text needs to refer clearly to the attached appendices (if applicable). It should also 
explain how the material in the appendices relates to the text. If the content does not 
really matter, you should probably drop the appendix. References to multipage 
appendices need to be specific to the page or section of the appendix, not just a 
general reference to “Appendix B.” Number appendices pages consistently.  

• Test the document for accessibility using the Microsoft Office Accessibility Checker. (See 
Chapter 6: Document Accessibility.) 
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Apply general rules for good writing to all reports and other written materials created or 
funded by the CEC. MPCO recommends the following books and website to help authors 
develop good writing habits:  

• Sabin, William A. The Gregg Reference Manual (Tribute [Eleventh] Edition). McGraw-Hill 
Irwin, 2011. ISBN: 0072936533.  

• Fiske, Robert Hartwell. To the Point: A Dictionary of Concise Writing. W.W. Norton & 
Company, Inc., 2014. ISBN: 978090383347173  

• Strunk Jr., William, E. B. White, The Elements of Style, The Original Edition. 
www.bnpublishing.com, 2008. ISBN: 9562919897.  

• Style Manual Committee, Council of Science Editors. Scientific Style and Format: The 
CSE Manual for Authors, Editors, and Publishers (Seventh Edition). University of 
Cambridge, 2006. ISBN: 097796650X.  

• University of Chicago Press Staff (Editor). The Chicago Manual of Style (16th Edition). 
University of Chicago Press, 2003. ISBN: 0226104036.  

• U.S. Energy Information Administration Office of Communications. EIA Writing Style 
Guide. 2015. http://www.eia.gov/about/eiawritingstyleguide.pdf. 

 

The above sources may disagree on grammar and punctuation formatting, such as using a 
serial comma. The CEC’s preference for reports is The Gregg Reference Manual. The MPCO 
recommends that each CEC office have at least one copy of that manual. 

If you have a question about what the report should include, contact the Media Office Editing 
Unit to discuss the report. Make sure you understand all the required parts.  

Writing Style  
Use the active voice whenever possible:  

• ACTIVE VOICE: The petroleum industry builds new storage facilities. 
• PASSIVE VOICE: New storage facilities are built by the petroleum industry. 

The CEC discourages the use of the first person (I, we, us, our) when referring to the 
author(s) in its reports. This admonition is not to say that you should write in the passive 
voice. It is possible to write in the third person and still use the active voice. For example:  

• Instead of third person passive voice: “It was found by the research team, or it was 
found by the researcher that ...” 

• Use third person active voice: “The research team or the researcher found that ...” or 
“The study found that ...” or “Results showed that ...”  

Writing in the third person requires that the authors refer to themselves as though they were 
referring to a third party:  

• First person: “We considered 12 scenarios ...” 

https://www.eia.gov/about/eiawritingstyleguide.pdf
https://www.eia.gov/about/eiawritingstyleguide.pdf
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• Third person: “The authors [or “the research team” or “the researcher” or “this project” 
or some other similar third-party reference] considered 12 scenarios ..."  

• Eliminate excess words. For example, say, “To calculate the emissions...” NOT “In order 
to calculate the emissions ...” The Dictionary of Concise Writing can help writers use 
fewer words to convey their message. For example, say, “The team analyzed ...” and 
not “The team conducted an analysis of ...” Other unnecessary words include “process,” 
“activities,” “efforts,” and “for the purposes of.” 

• Avoid using “etc.,” “e.g.,” or “i.e.” Instead, use “and so forth,” “for example,” or “that 
is,” respectively, or another appropriate substitute.  

Acronyms and Abbreviations 
An acronym is an abbreviation made up of the initial letters of a group of words and is 
pronounced as a single word. For example, HVAC (heating, ventilation, and air conditioning) is 
pronounced “H–VAC.” Abbreviations are the initial letters of a group of words but cannot be 
pronounced as a single word and in which each letter is spoken individually, such as CPUC and 
PG&E. The CEC uses these two terms interchangeably, most often including abbreviations 
under the umbrella of acronyms. 

Use acronyms sparingly! They are a form of shorthand for terms used repeatedly 
that are familiar to your readers. Do not make up your own acronyms. This style of 
writing excludes the reader by introducing words that are known to only a “select few.” 

An acronym should benefit the reader, not cause them to stop reading and start hunting for 
the first time the acronym was used. Limit the use of acronyms in the executive summary to 
those in the following table. Acronyms may be disallowed at the discretion of the CEC editors. 

Follow these rules when using acronyms or abbreviations. 

• Do not make up acronyms as shorthand for a group of words. 
• Use “California Energy Commission” at first mention, and then use “CEC” throughout 

the rest of the report. You may also use just “Commission” in subsequent references in 
the same paragraph as long as no other commissions are being mentioned. Return to 
using “CEC” in subsequent paragraphs. 

• Introduce acronyms by first using the full term, followed by the acronym in 
parentheses. CEC style does not allow the use of acronyms in the abstract and 
executive summary because these sections may need to stand alone and because these 
elements are often read by a broader audience that may be less familiar with the 
subject matter. Very common acronyms or abbreviations are acceptable in abstracts 
and executive summaries. (See Table 5.) 

• Do not introduce and use an acronym if it only appears once or twice in proximity. Rare 
exceptions would be cases where readers are more familiar with the acronym than the 
actual referent. 

• Do not use the U.S. Postal Service two-letter abbreviations for states in the United 
States. Instead, use the full state name (example: Sacramento, California). 
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• Do not use “DAC” for “disadvantaged community.” 

Table 7: Common and Acceptable Acronyms and Abbreviations 
Original Term Acronym/Abbreviation 

Battery-electric vehicle BEV 

California Air Resources Board CARB (as of January 2016) 

California Department of Forestry and Fire 
Protection 

CAL FIRE 

California Department of Resources 
Recycling and Recovery 

CalRecycle 

California Energy Commission CEC or Energy Commission 

British thermal unit Btu 

California Department of Water Resources DWR 

California Environmental Protection Agency CalEPA  

California Independent System Operator California ISO or ISO (not CAISO or Cal-ISO) 

(California) Public Utilities Commission CPUC 

California Department of Transportation Caltrans 

carbon dioxide CO2 or CO2 (Note: Make sure the 2 is not too 
small to read.) 

community choice aggregator CCA 

cubic feet per minute CFM 

(United States) Department of Energy U.S. DOE 

distributed energy resource DER 

Electric Program Investment Charge EPIC 

Energy Action Plan Energy Action Plan (not EAP) 

Energy Efficiency Ratio, Seasonal Energy 
Efficiency Ratio 

EER, SEER 

ENERGY STAR® ENERGY STAR® on first reference with 
registered trademark in superscript, followed 
by ENERGY STAR thereafter. Note: Can be all 
capitals. 

Federal Energy Regulatory Commission FERC 
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fuel cell electric vehicles FCEV 

Governor’s Office of Business and Economic 
Development 

GO-Biz 

greenhouse gas GHG 

heating, ventilation, and air conditioning HVAC 

Integrated Energy Policy Report IEPR 

integrated resource plan IRP 

kilovolt kV 

kilowatt/kilowatt-hours kW (small k, capital W)/kWh 

liquefied natural gas, liquefied petroleum 
gas 

LNG, LPG 

Los Angeles Department of Water and 
Power 

LADWP 

Low Carbon Fuel Standard LCFS 

megawatt/megawatt-hour MW (all capitals)/MWh 

million British thermal units MMBtu 

nitrogen oxides NOx or NOx 

Nuclear Regulatory Commission NRC 

Organization of Petroleum Exporting 
Countries 

OPEC 

Pacific Gas and Electric Company PG&E 

photovoltaic PV 

PIER Public Interest Energy Research 

plug-in electric vehicle PEV 

one quadrillion (1015) British thermal units Quad 

research, development, and demonstration RD&D 

Sacramento Municipal Utility District SMUD 
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San Diego Gas & Electric Company  
(Note: An ampersand is the correct usage 
in the company name.)  

SDG&E 

Southern California Edison Company SCE 

Southern California Gas Company SoCalGas 

sulfur oxides SOx or SOx 

Terawatt TW, 1 trillion watts 

thousand cubic feet MCF but in parentheses say (1,000 cubic feet 
of natural gas) 

United States United States (not U.S. unless it proceeds an 
abbreviation for a federal agency) 

United States Environmental Protection 
Agency 

U.S. EPA (not EPA) 

Source: California Energy Commission, Media and Public Communications Office 

Bulleted Lists  
Consider using a bulleted list for complicated sentences like the following example:  

This report provides policy recommendations to conserve resources; protect the environment, 
the economy, and public health and safety; and ensure reliable, secure, and diverse energy 
supplies.  

The above is correct, but it is clearer if bullets are used.  

 This report provides policy recommendations to:  

• Conserve resources. 
• Protect the environment, the economy, and public health and safety. 
• Ensure reliable, secure, and diverse energy supplies. 

 
Note: The Gregg Reference Manual (p. 9, paragraph 107a) states: “... use periods after short 
phrases that are essential to the grammatical completeness of the statement introducing the 
list.”  

In the example, do not put the conjunction “and” at the end of the second bullet. The above 
bulleted items are incomplete sentences, but because they grammatically complete the lead-in 
phrase, periods are used. 

Rules for Bullets 
If a bullet makes a complete sentence or completes the lead-in, use a period. If not, no period 
should be used. 
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In bulleted lists, use “parallel construction” for the items in your list. For example, if one item 
starts with a verb, all items should start with a verb; if one item begins with a noun, all items 
should begin with a noun, and so forth.  

Use the following guides for punctuating bulleted lists:  

• Start each bulleted element with a capital letter. 
• Place a period at the end of each listed element that is a complete sentence. 
• Incomplete sentences should not have a period unless they are “essential to the 

grammatical completeness of the list.” (See note above.) 
• Do not use semicolons or commas as end marks. 
• The word “and” should not end the second-to-last bulleted item. 

 Do not use small graphic files in place of the standard bullets.  

Format for Bulleted Lists 
1)  The hierarchy for bullets should be: 

• Bullet item (round, solid disc). 
o Second-level bullet (open circle). 
 Third-level bullet (solid square). 

- Fourth-level bullet (hyphen). 
2)  Add an additional return (extra line) at the end of the bullets and before the next 

paragraph. 

3)  Bullets use standard/normal text (Tahoma normal, 12 pt.) but should have only 4 pt. 
spacing following the paragraph. It is included in the blank document template, but you 
may have to change this manually. To do that, highlight the bulleted section and go to 
pull-down menu:  

Format>Paragraph>Indents and Line Spacing>Spacing After = 4 pt. 

4)  Always format bullets with a hanging indent, indenting 0.25-inch from the line above 
with the hanging indent at 0.50-inch from the line above. 

Capitalization  
Do not capitalize words to make them stand out in a text. For example, “The Department 
offered its services” is incorrect and should be “The department offered its services.” 
Capitalization should be reserved for proper nouns, which are names of specific persons, 
places, or things. 

Just because acronyms and abbreviations are most often capitalized does not mean that you 
must capitalize the terms when they are written out. For example, you would not capitalize 
heating, ventilation, and air-conditioning (HVAC) system before listing the acronym in 
parentheses. 
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Do not capitalize words in the following situations:  

• Use “energy crisis,” NOT “Energy Crisis.” A proper noun, however, like “2020 Summer 
Olympics” would be capitalized. 

• Use the lower case for “project” or “program” or “model” unless the term is an official 
part of a name or title, such as “Sunrise Transmission Project” or the “Cost of 
Generation Model.” (In subsequent references to the project or program or model, use 
the lower case for the term even though it capitalized when you use the official name. 
For example, regarding the Sunrise Transmission Project, subsequent mentions would 
be to “the project” if you don’t want to use its full name.)   

• Use “website” (all one word, lowercase) and not “Website” or “web site.” However, use 
“Web page,” “Webmaster,” and “the Web.” Per the Gregg Reference Manual, to 
maintain a consistent style, it is better to retain the capital “W” until the majority of 
these terms (such as “World Wide Web”) lose the initial cap as well. “Website,” 
however, has lost the initial cap in most technology publications, newspapers, and 
websites. 

• Do not capitalize “city” before the name of a municipality unless it is part of its formal 
name. For example, “city of Sacramento,” not “City of Sacramento.” The actual name of 
the city is Sacramento, California. For some cities, the word “city” is part of its formal 
name, such as the City of Industry, California. 

• Do not capitalize any term that is not a proper name or title. 
• Do not capitalize “staff.” 
• Do not capitalize “state.” 

Words that should be capitalized are:  

• Governor, Legislature, Senate, and Assembly (when pertaining to California).  
• Northern California, Southern California, and Central California.  
• Cap-and-Trade Program, according to the California Air Resources Board. 

Titles like “chair,” “vice chair,” and “executive director” can be capitalized when used before a 
name but not when used alone. 

The terms that are capitalized may disagree with some grammar conventions. These are CEC 
style for using these terms. 

Adjective Phrases and Adverbs  
Do not hyphenate adjective phrases: “publicly owned utilities,” or adverbs: “newly 
created.” 

Compound Adjectives  
Many compound adjectives are hyphenated when they come before a noun: “investor-owned 
utilities.” They are not hyphenated when they come after the verb: “the utilities are investor 
owned.” 
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Internet and Email Addresses 
You can configure Microsoft Word to create hyperlinks automatically to Internet addresses 
(URLs, short for “Uniform Resource Locator”) and a mail-to link for email address. Creating the 
hyperlink changes the text to blue and underlines the text (in Word default settings). When a 
user clicks on the link, the text color changes to purple. Changing the Word file to Adobe 
Acrobat sometimes incorporates the hyperlinks. Please make sure the addresses are correct 
and tested before submitting a report.  

Note: Email in CEC documents should be spelled without a hyphen, following The Associated 
Press Stylebook and Libel Manual. 
Try not to split Internet addresses across two lines. If you need to, put the website address on 
a separate line, centered. Or if the URL is still too long, reduce the point size. For example: 

http://www.energy.ca.gov/2007publications/CEC-180-2008-001/CEC-180-2008-001.PDF 

http://www.energy.ca.gov/2007_energypolicy/notices/2007-08-16_workshop_notice.html 

Italics  
Italicize the name of all books and reports. For example, use 2019 Integrated Energy Policy 
Report and 2018 Energy Policy Report Update. Do not underline. If the information cited is 
from a magazine, put the article title in quotations and the magazine name in italics. 

Use italics, not quotation marks, to introduce new technical terms. Include such terms in a 
glossary, if appropriate. 

Language of Report 
When writing the report, use American, not British, English. 

Legislation 
(Referencing Legislation in Energy Commission Documents) 
For consistency, the following format should be used when referencing all legislation in reports 
or other documents: 

Bill # (Author, Chapter #, Statutes of “year”) 

Examples: Senate Bill 100 (De León, Chapter 312, Statutes of 2018) 

Assembly Bill 8 (Perea, Chapter 401, Statutes of 2013) 

After that first reference, reference the bill as an abbreviation (SB 100 or AB 8) unless it has a 
formal title.  

If a bill has a formal title, the first reference should include the formal title followed by the bill 
information. For example: 

• Petroleum Industry Information Reporting Act (Senate Bill 1444, Holmdahl, Chapter 
1055, Statutes of 1980) 
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• Global Warming Solutions Act (Assembly Bill 32, Núñez, Chapter 488, Statutes of 2006) 
After that first reference, reference the bill as a shortened title (PIIRA or whatever the 
act is commonly called). 

Numbers  
In a list in linear text, use numbering (in parentheses) to indicate the order in which tasks 
should be done, to suggest chronology or relative importance among the items, or to clearly 
separate the items. For example:  

When repairing the machine, the researchers (1) gathered the parts, (2) assembled the 
subsystems, (3) connected the subsystems, and (4) conducted tests to establish baseline 
performance.  

When establishing the policy, the state considered (1) wind turbines, old and new; (2) energy 
conservation programs that encourage consumers to reap the benefits of off-peak electricity; 
and (3) photovoltaic installations—including emerging technologies that use thin-film 
materials—in regions with superior insulation. 

Otherwise, do not use numbering, as in the following example:  

There are three key drivers of natural gas prices: supply, demand, and storage capacity.  

It may be clearer, however, to use numbered bullets instead of a list in linear text. 

Here are other rules for numbers: 

• Use numerals for 10 and above; spell out all numbers one through nine, EXCEPT when 
identifying:  

o Percentages (2 percent)  
o Dates (June 2, 2005)  
o Page numbers (page 6)  
o Chapter numbers (Chapter 4) 
o Energy increments (1 megawatt, 9 kilowatts) 
o Sentences that include a list of identical items, some of which are fewer than 10 

and some are more: “We ran 2 trials in April, 5 in May, and 14 in June.” 
o Table and figure numbers (Table 4, Figure 6). 
o Numbers between 10 and 1 million. For example, use 680,000, NOT 680 

thousand. 
• Always use commas in numbers that are five digits or larger: 12,400, 245,678.  
• Insert commas four-digit numbers when they are used in tables or columns and are 

optional in text, unless needed to make the number clear.  
• Never begin a sentence with a numeral, including a year. “The energy crisis began in 

2000,” NOT “2000 marked the year the energy crisis began.” 
• Always use a zero before a fraction smaller than 1.0. Use 0.25, not .25. 
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• Treat related numbers alike:  
 Last year we sold 21,557,000 items; this year, nearly 23,000,000.  

• Repeat the word million (billion, trillion, and so forth) with each figure to avoid 
misunderstanding: 
 $5 million to $10 million (NOT: $5 to 10 million). 

• Do not use an en dash or hyphen if a numerical sequence is introduced by the word 
“from” or “between.” For example, “from 1998 to 2001” or “between 2009 and 2019.” 

• Write out ordinal numbers (numbers that indicate rank) under 10. Use numerals for 
ordinal numbers 10 and greater. Do not use superscripts for the letters in ordinal 
numbers. For example, write 20th instead of 20th. 

• Use the metric system (International System of Units, or SI) or English units—
whichever is most appropriate to the report. When referring to temperatures, however, 
use Fahrenheit along with Celsius following in parentheses—for example, 212ºF 
(100ºC). There should not be a space between the temperature, the degree symbol, 
and the letter. For executive summaries, use both SI and English units of measurement, 
to support a greater understanding by a lay audience. Use of other standard English 
measures (for example, acre-foot, two-by-fours) is always appropriate.  

Page Breaks  
If a subheading is at the bottom of the page, but the text jumps to the next page, put a page 
break before the subheading. Including a page break will ensure that headings are not left 
alone at the bottom of a page with no content if the Word file is opened on a different 
computer. 

Percentages 
Always spell out the word “percent” instead of using the % symbol except when used in a 
chart or graph, even in project reports. For example: 

• The U.S. Labor Department reported that September unemployment rate fell 0.2 
percent. 

• The sales tax rate in California can vary from 7.0 to as much as 10.25 percent. Fifty 
years ago, the tax rate was 2.5 percent. It increased to 3.5 percent four decades ago. 
It has never gone down. 

Punctuation  
Brackets 
Use brackets for parenthetical material within parentheses. (Within the parentheses, separate 
the text [parenthetical material] from the rest of the sentence.)  
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Colon and Semicolon 
Use only one space (not two) after a colon or a semicolon. Moreover, do not use a colon 
between a verb or a preposition and the direct object unless the object appears on a separate 
line. 

Commas  
Use a serial (Oxford) comma style throughout the report.  

Example: The research team tested the first, second, and third models.  

Note: The comma after “second” is called the serial or Oxford comma, and it separates the 
terms in a simple series.  

In a serial list that has multiple units in each element of the list, use a semicolon instead of a 
comma to clarify groupings. 

Example: The breakfast menu items were coffee, tea, fruit juice, or milk; bacon and eggs; 
cold cereal and milk; hot oatmeal with cinnamon, apples, and cream; assorted sweet rolls; or 
fresh fruit and yogurt. 

Use commas to set off the main elements in an address or a title following a person name.  

Example: The Energy Commission has been at 1516 Ninth Street, Sacramento, California, for 
more than 20 years.  

Example: Mary Jones, director of the project, oversees the contract. 

Commas in Dates  
Do not put a comma between a month and a year (July 2007), but do put a comma between a 
date and the year and after the year if in a sentence.  

Example: The Declaration of Independence was signed on July 4, 1776, in Philadelphia, 
Pennsylvania.  

Note: Use the standard American method of dating of month, date, and year.  

Hyphen (-), En Dash (–), Em Dash (—)  
When in doubt about whether to hyphenate a word, look it up in the dictionary or The Gregg 
Reference Manual. Words with the prefix “non,” “anti,” “pre,” “pro,” “multi,” “co” are not 
hyphenated, except when “non” is used with a proper noun, such as non-English.  

Words with a prefix that ends in the same letter as the root word are hyphenated.  

 Example: She suffered from a preexisting condition.  

Use for any set of words you want understood as one unit but use them sparingly.  

 Example: It was an out-of-date idea.  
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Use to join compound modifiers, unless one of the words is an adverb ending in “-ly.” 
Compound modifiers are two or more adjectives or adverbs that, if used separately, do not 
describe the word they modify: 

• The utility offers consumers many energy-saving ideas. 
• She was a newly elected senator. (“-ly” adverb, no hyphen)  

Use an em dash (—) between words but insert a space on either side of the dash. From 
the Insert Menu, select Symbol > Special Characters > em dash. 

Use an en dash (–) to show a range between numbers. Do not add a space before and after 
the en dash. From the Insert Menu, select Symbol > Special Characters > en dash. 

Period Spacing  
Use a single space after a period. Do not double space. 

Quotation Marks (“”)  
Use around titles of chapters, sections, article titles, or a coined word or phrase.  

• We read the chapter “Progress in Energy Programs,” from the Energy Efficiency Report: 
2018.  

• The staff reviewed the “widget” design. 

Special Characters and Symbols 
Microsoft Word has a listing of special characters that you can use when typing. To view the 
special characters, go to Insert > Symbol. These special characters make use of the “Symbol” 
typeface that comes with and is installed by Microsoft Word. These special characters are the 
same across computer platforms. For symbols that are not in the standard typeface or font 
family, please contact Media and Public Communications Office to discuss using them in a 
report.  

Underlining 
Do not use underlines. Use bold or italics. 
Do not use underlines to differentiate a header or section. Use the style setting for that 
heading. 
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CHAPTER 8: 
Footnotes and References in the Text 

References Within the Report Body 
When referencing a report, book, or other document within the body of the report, use the 
format as described in The Chicago Manual of Style, 16th Edition.  
Referencing is referring someone to the source. References (also called "citations") show the 
reader what different aspects of your work are based on. Insert the reference in parentheses 
to lead the reader to information about the page of a book or other source that is the evidence 
for what you have said. 

For example: When you see a reference, like this: (Robinson, C. E. 2015 p.23), in the text 
of a report, it means that you are being referred to page 23 of a book written by C. E. 
Robinson in 2015. To find out the title and publisher of the book, you look in the bibliography. 

Footnote Citations 
In footnotes, please use the following format after the footnote number: 

Authors, starting with last name first for the first entry only, then first and last names for 
subsequent authors. Year. “Title of Article.” (if available) Title of Publication, whether it is a 
book, report, fact sheet, pamphlet, or periodical. Name of publisher (if available). Publication 
Number, if published by the California Energy Commission. URL (if available).  

Examples: 

California Energy Commission staff. 2017 2017 Integrated Energy Policy Report. California 
Energy Commission. Publication Number: CEC-100-2017-001-CMF.  

Pollan, Michael. 2006. The Omnivore’s Dilemma: A Natural History of Four Meals. Penguin. 

If there are 10 or more authors, list the first seven followed by an et al. 

When citing from the same source as the previous footnote, use “Ibid.” 

If the author is unknown, start with the title, followed by the year. 
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CHAPTER 9:  
Submitting Files to the  
Media and Public Communications Office 

The CEC uses the Microsoft Office suite of software programs for word processing, 
spreadsheets, and presentations.  

When submitting reports to the MPCO, please send all files relating to the document, including 
original figures and graphic files. That way, the CEC will be able to replicate the document in 
the future or convert it into future publication formats (such as XML) as technology changes. 

Word and PDF Files 
Send copies of the full documents as Microsoft Word .docx files.  

When saving the file, please make sure that the copy has all tracked changes accepted into 
the final version, unless it is undergoing further editing. 

Convert all Word files into Acrobat Portable Document Format (PDF) files by saving as Adobe 
PDF. 

Do not password protect or encrypt Word documents or PDF files. 

Document Properties 
The properties of the file must be filled out in Word and in the PDF. Go to File > 
Properties menu in either program and complete the information in the summary or 
description portion. The areas that must be filled out are: 

Word Properties Acrobat Properties 
 Title  Title 
 Subject  Author 
 Author  Subject 
 Manager  Keywords 
 Company (Calif. 

Energy 
Commission) 

 

 Category 
(optional) 

 

 Keywords  
 Comments 

(optional) 
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File names should be descriptive of the report. So when the Word file is sent to the Energy 
Commission, it can be named anything as long as it is descriptive. The file name for the Word 
and PDF files will eventually be given the publication number of the report or appendix. For 
example, CEC-180-2020-001.PDF is the file name for the PDF file for this style manual. 

You should also set the properties of a PDF file so that the file fits the computer screen. This is 
set under the Acrobat Document Properties  Initial View.  Set the page layout to “single 
page.” Set the magnification to “fit page.”  

Graphics and Figures 
The author must send a copy of ALL graphic files used in the report along with the final 
document file. These files should be sent to the CEC Webmaster on the P: Drive if they cannot 
be sent easily via email. 

The following are things to remember regarding graphics, photographs, and images of figures. 

• Embed the graphic in the report document but also save each file separately from the 
main report.  

• Save photos in their original or raw digital format (if available) as well as in JPG or PNG. 
Do not use TIF or GIF files unless forced to. 

• If a photo is manipulated to change contrast or fix elements, save files in Adobe 
Photoshop® PSD format (please include layers if used) and in JPG or PNG formats. 
Please make a notation that photo was manipulated and what was done. 

• Save illustrations and graphic elements in their original format such as Adobe 
Illustrator, Adobe InDesign, or Macromedia Freehand. 

• Graphics and photographs should be saved at a higher resolution, at least 300 dpi. Do 
not use lower-resolution (72 or 96 dpi) graphics that are found on websites, as they do 
not reproduce well in printed documents. 

• Label graphic files names so they correspond with their figure title in the report. For 
example, if you have a photograph used as Figure 23, label the file name as 
figure_23.jpg. 

• Use underscores (_) between words in file names instead of spaces.  
• Do not use the following characters in a file name: ! @ # $ % ^ & * ( ) : ; { } [ ] / \| 

CEC publications are in the public domain because they are funded by public money. As such, 
photographs or other graphic files also are in the public domain. The CEC reserves the right to 
use photographs or other graphic files in other publications or on the CEC website. 
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